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Kirish 

Oʻzbekiston mustaqillikka erishgandan soʻng fan va turmush sohasida juda 

katta yutuqlarga erisha boshladi va astoydil rivojlanish taraqiyyot yoʻliga kirdi. 

Uzoq yillardan soʻng buyuk ajdodlarimizning ezgu maqsadlari roʻyobga chiqdi. 

Prezidentimiz Islom Abdugʻaniyevich Karimov oʻzining “Yuksak ma’naviyat 

yengilmas kuch” asarida –“Biz halqimizning dunyoda hech kimdan kam 

boʻlmasligimiz, farzandlarimiz bizdan koʻra kuchli, bilimli, dono va albatta baxtli 

boʻlib yashashi uchun bor kuch va imkoniyatlarimizni safarbar etayotgan ekanmiz 

bu borada ma’naviy tarbiya masalasi hech shubhasiz beqiyos ahamiyat kasb etadi. 

Agar biz bu masalada hushyorlik va sezgirligimizni, qat’iyat va ma’sulyatimizni 

yoʻqotsak, bu oʻta muhim ishni oʻz holiga, oʻzi boʻlarlikka tashlab qoʻyadigan 

boʻlsak, muqaddas qadryatlarimizga yoʻgʻirilgan va ulardan, tarixiy xotiramizdan 

ayrilib oxir-oqibatda oʻzimiz intilgan umumbashariy taraqqiyot yoʻlidan chetga 

chiqib qolishimiz mumkin” – deb ta’kidlaganlar [1]. 

 Hozirgi kunda Oʻzbekiston Respublikasida amalga oshirilayotgan 

islohatlarning ijobiy natijalaridan eng muhimi sifatida davlat tomonidan yosh 

avlodga ta’lim berish va tarbiyalash borasida qilinayotgan ishlarni alohida 

ta’kidlash lozim. Mamlakatimizning birinchi prezidenti I.A.Karimovning 

raxnomoligi va bevosita ishtirokida ishlab chiqilgan “Kadrlar tayyorlash milliy 

modeli va dasturi” Oʻzbekiston mustaqilligining yutugʻi va samarasi ekanligini 

aytib oʻtish maqsadga muvofiqdir. Mustaqillik sharoitidagini keng miqiyosli 

ijtimoiy loyihalarni hal etish imkoni tugʻildi. 

 Darhaqiqat, jamiyat oʻz oldiga qanday vazifa va maqsad qoʻymasin, qanday 

muammolarni yechish zarurati va ehtiyoji tugʻilmasin, gap oxir oqibat baribir 

yetuk mutaxassis kadrlarga borib taqalishi tabiiy [2]. 

 Birinchi prezidentimizmiz soʻzlari bilan aytganda “Bizning kelajagimiz, 

mamlakatimizning kelajagi oʻrnimizga kim kelishga, yoki boshqacharoq aytganda 

qanday kadrlar tayyorlashimizga bogʻliq. Kadrlar tayyorlsh boʻyicha milliy 

dasturni amalga oshirish hech bir mubolagʻsiz strotegik maqsadlarimiz – farovon, 
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qudratli, demokratik davlat, erkin fuqorolik jamiyati barpo etishimizning asosi 

bolmogʻi zarur” 

 Prezidentimiz I.A. Karimov tomonidan maktab sohasida “ta’lim haqida” gi 

qonun qabul qilingan. 1996-1997 oʻquv yilidan boshlab maktablarning birinchi 

sinflarida oʻqish yangi alifboda olib borildi. Yangi imlo, alifboda oʻqitish uchun 

zarur dastur, qoʻllanma va darsliklar yaratildi.  

 Shu davr mobaynida 300 ga yaqin yangi turdagi ta’lim muassasalari ochildi. 

Oily oʻquv yurtlari qoshida litseylar tashkil etildi, 800 ga yaqin oʻquvchi chet 

ellarda ta’lim oldi, koʻpgina oʻqituvchilar xorij davlatlarining ilgʻor tajribalarini 

oʻrganish maqsadida chet mamlakatlarga borib qaytdilar [3]. 

 Yoshlarimiz haqli  ravishda  Vatanimizning  kеlajagi  uchun  javobgarlikni  

zimmasiga  olishga  qodir  boʻlgan, bugungi va  ertangi  kunimizning  hal  etuvchi  

kuchiga aylanib borayotgani barchamizga  gʻurur  va  iftixor  bagʻishlaydi. Bu 

sohada olib borayotgan kеng miqyosli ishlarimizni, xususan, ta’lim-tarbiya 

boʻyicha qabul qilingan umummilliy dasturlarimizni mantiqiy yakuniga 

yеtkazishimiz zarur. Shu maqsadda hukumatning, tеgishli vazirlik va idoralar 

hamda butun ta'lim tizimining, hurmatli domlalarimiz va profеssor-

oʻqituvchilarning eng muhim vazifasi - yosh avlodga puxta ta'lim bеrish, ularni 

jismoniy va ma'naviy yеtuk insonlar etib tarbiyalashdan iboratdir. Farzandlarimiz 

uchun ish joylari yaratish, ularning hayotda munosib oʻrin egallashini ta'minlashga 

qaratilgan ishlarimizni yangi bosqichga koʻtarishni davrning oʻzi taqozo etmoqda. 

Biz yoshlarga doir davlat siyosatini hеch ogʻishmasdan, qat'iyat bilan davom 

ettiramiz.  Nafaqat davom ettiramiz, balki bu siyosatni eng ustuvor vazifamiz 

sifatida bugun zamon talab qilayotgan yuksak darajaga koʻtaramiz. 

Yoshlarimizning mustaqil fikrlaydigan, yuksak intеllеktual va ma'naviy 

salohiyatga ega boʻlib, dunyo miqyosida oʻz tеngdoshlariga hеch qaysi sohada 

boʻsh kеlmaydigan insonlar boʻlib kamol topishi, baxtli boʻlishi uchun davlatimiz 

va jamiyatimizning bor kuch va imkoniyatlarini safarbar etamiz [4].  
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 Mamlakatimizda sogʻlom va barkamol avlodni tarbiyalash yoshlarning oʻz 

ijodiy va intelektual salohiyatini roʻyobga chiqarishi, mamlakatimiz yigit va 

qizlarini XXI asr talablariga toʻliq javob beradigan har tomonlama rivojlangan 

shaxslar etib voyaga yetkazish uchun zarur shart sharoitlar va imkoniyatlari 

yaratish boʻyicha keng koʻlamli aniq yoʻnaltirilgan chora tadbirlarni amalga 

oshirish maqsadida, shuningdek, Oʻzbekiston Respublikasida 2010-yilning 

“Barkamol avlod yili” deb e’lon qilingani munosabati bilan Oʻzbekiston 

Respublikasi birinchi prezidenti I.A. Karimov tomonidan “Barkamol avlod yili” 

davlat dasturi tasdiqlandi. Dasturda quyidagi asosiy vazifalar belgilab oʻtilgan: 

 Davlat ta’lim standartlari, oʻquv dasturi va oʻquv uslubiy adabiyotlarni 

takomillashtirish; 

 Ta’lim jarayoniga yangi axborot kommunikatsiya va pedagogik 

texnologiyalarni, elektron darsliklar, multimediya vositalarini keng joriy etish 

orqali mamlakatimiz maktablarida, kasb-hunar kollejlarida, litsey va oily oʻquv 

yurtlarida oʻqitish sifatini tubdan yaxshilash ta’lim muassasalarining oʻquv 

laboratoriya ba’zasini zamonaviy turdagi oʻquv va laboratoriya uskunalari, 

kompyuter mexanikasi bilan mustahkamlash, shuningdek oʻqituvchilar va 

murabbiylar mehnatini moddiy hamda ma’naviy ragʻbatlantirish boʻyicha samarali 

tizmni yanada rivojalntirish va boshqalardan iborat. 

 Shunday ekan biz yosh kadrlar, vatanimiz ravnaqi uchun bor bilim va 

imkoniyatlarimizni ishga solib, mustaqil Oʻzbekistonimizda ta’lim-tarbiyani 

rivojlantirish uchun sitqidildan harakat qilamiz. 

 Magistrlik dissertatsiyasi mavzusining asoslanishi va uning dolzarbligi.  

 Ferrotsen va uning hosilalari reaksion qobiliyati va amaliy ahamiyati jihatidan 

“Metallosenlar kimyosi” da alohida oʻrin egallaydi. Ferrotsen hosilalarida 

boradigan reaksiyalar, jumladan, alkillash, atsillash, elektrofil va nukleofil oʻrin 

olish, sulfolash, nitrolash, arillash reaksiyalari koʻplab tadqiqotchilar tomonidan 

oʻrganilgan. Alkillash reaksiyalari alohida oʻrin egallaydi. Hammamizga 

ma’lumki, ferrotsen va uning hosilalari organik sintezda; biostimulyator olishda, 

antidetonator sifatida; antianemik xususiyatli birikmalari dori sifatida, ayrim 
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bioyelimlar tibbiyotda ishlatiladi. Bundan tashqari koʻplab birikmalari dorivor 

xususiyatlarga ega. Shu bois ferrotsen hosilalarining reaksion qobiliyatini yanada 

mukammalroq oʻrganish talab etiladi.  

 Tadqiqotning ob’yekti va predmeti. Alkillash reaksiyalari toʻgʻrisidagi 

ma’lumotlar yozilgan adabiyotlar, internet ma’lumotlari, matbuot va ilmiy 

jurnallarda, konferensiyalarda e’lon qilingan ma’lumotlar, maqolalar mavzuning 

oʻrganish ob’yekti hisoblanadi. 

 Ilmiy-tadqiqot ishining predmeti, p-ferrotsenilfenol va ferrotsenilbenzoy 

kislotasi, alkillovchi reagentlardan iborat. 

 Tadqiqotning maqsadi va vazifalari. p-Ferrotsenilfenol va 

ferrotsenilbenzoy kislotasining alikillash reaksiyalarini kvant kimyoviy asoslash, 

ya’ni ferrotsen va uning hosilalarini alkillash reaksiyasi toʻgʻrisida yozilgan 

adabiyotlarni, internet ma’lumotlarini toʻplash, ularni tahlil qilish, berilgan 

ma’lumotlarni bir – biriga solishtirish va shu reaksiyani borish shart sharoitlarini, 

mexanizmini, reaksiya natijasida hosil boʻladigan mahsulotlarni kvant kimyoviy 

tahlil qilish va amaliy ahamiyatini oʻrganishdan iborat. 

 Tadqiqotning yangiligi. Ferrotsen va uning hosilalari halq xoʻjaligining turli 

sohalarida foydalaniladigan moddalarni sintez qilishdagi ahamiyati beqiyosdir. 

Ilmiy ishning yangiligi p-ferrotsenilfenol va ferrotsenilbenzoy kislotasi alkillash 

reaksiyalari mexanizmlarini kvant kimyoviy tahlil qilish. Bundan tashqari sintez 

mahsulotlari zamonaviy kvant kimyoviy metodlar orqali oʻrganilganligi. 

 Tadqiqotning asosiy masalalari va vazifalari. Mavzuning asosiy masalasi 

metallosenlarning alkillash reaksiyalarini amaliy ahamiyatini oʻrganish. Bundan 

tashqari reagent va hosilalarni geometrik kattaliklarini zamonaviy kvant kimyoviy 

metodlar yordamida tahlil qilish. Amaliyot uchun zarur boʻlgan biologik faol 

modda sintez qilish shart-sharoitlarini oʻrganish va uni amaliyotga joriy etish. 

 Tadqiqot mavzusi boʻyicha adabiyotlar tahlili. Ferrotsen va uning 

hosilalasida boradigan alkillash reaksiyalarining amaliy ahamiyatiga doir 34 ta 

adabiyotlar, internet ma’lumotlari, ommaviy axborot vositalarida chop etilgan 

maqola va tezislar toʻplanib, tahlil qilindi hamda ma’lumotlar taqqosandi. 
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 Tadqiqotda qoʻllanilgan metodikaning tavsifi. p-Ferrotsenilfenol va 

ferrotsenilbenzoy kislotasi alkillash reaksiyalaririning amaliy ahamiyatini 

oʻrganishda  ananaviy va zamonaviy kvant kimyoviy metodlardan foydalanildi. 

Reagentlar va mahsulotlarning energetik kattaliklarini hisoblash Gaussian 98W 

dasturida DFT/B3LYP gibrid metodining 3-21G va 6-31G bazislarida olib borildi. 

 Tadqiqot natijalarining nazariy va amaliy ahamiyati. Ushbu magistrlik 

ishi kimyoviy reaksiyalarni zamonaviy kvant kimyoviy usullar bilan asoslashga 

bag’ishlangan. Mazkur magistrlik ishida keltirilgan ma’lumotlardan foydalangan 

holda Oliy ta’lim muassasalarida hamda kimyo yo’nalishiga chuqurlashtirilgan 

muassalarning o’qituvchi va o’quvchilari uslubiy qo’llanma sifatida foydalansa 

bo’ladi. Ilmiy ishning amaliy ahamiyati quyidagilardan iborat: 

a) iqtisodiy samaradorlik; 

b) ekologik xavfsizlik. 

Ish tuzilmasining tavsifi. Ushbu magistrlik ilmiy ishi kirish, adabiyotlar 

tahlili, asosiy qism, amaliy qism, olingan natijalarning kvant kimyoviy tahlili, 

mavzu yuzasidan takliflar, xulosalar, 34 ta foydalanilgan adabiyotlar roʻyxati va 

ilova kabi boʻlimlardan tarkib topgan boʻlib, 97 bet, 13 ta jadval, 20 ta rasmlardan 

iborat. 

 Kirish qismida: magistrlik dissertatsiyasi mavzusining asoslanishi va uning 

dolzarbligi, tadqiqotning ob’ekti va predmeti, tadqiqotning maqsadi va vazifalari, 

tadqiqotning yangiligi, tadqiqotning asosiy masalalari va vazifalari, tadqiqot 

mavzusi boʻyicha adabiyotlar tahlili, tadqiqotda qoʻllanilgan metodikaning tavsifi, 

tadqiqot natijalarining nazariy va amaliy ahamiyati keltirilgan. Ilmiy ishning 

amaliy qismida p-ferrotsenilfenol va ferrotsenilbenzoy kislotalarining Fridel-Krafts 

usulida alkillash reaksiyalari Gaussian 98 W dasturida modellashtirilgan. Olingan 

natijalar muhokamasi bobida oʻtkazilgan tajribalarning natijalari zamonaviy kvant 

kimyoviy tahlili keltirilgan. Foydalanilgan adabiyotlar roʻyxatida 34 ta adabiyot 

keltirilgan. 
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I BOB. ADABIYOTLAR TAHLILI 

1.1. Metallosenlarning kimyoviy tavsifi 

 Bugungi kunga kelib, ferrotsenlarga oid ma’lumotlar koʻplab adabiyotlarda 

yoritilib berilgan.  

Ferrotsen (disiklopentadiyeniltemir) temirning pentagonal antiprizmatik 

“sendvich” tuzilmasi boʻlgan metallorganik birikmasidir. Ferrotsenni birinchi 

boʻlib 1951-yil T.Kili va P.Poson yangi uglevodorod disiklopentadiyenil olish 

maqsadida C5H5MgBr ni FeCl3 bilan reaksiyasini olib borishdi. Kutilmaganda ular 

umuman boshqa yangi, juda ham mustahkam, temir saqlovchi, sariq-qizgʻish rangli 

kristall birikmani olishdi. Uni qanday tuzulganligini bilish uchun bir yil vaqt ketdi, 

shuncha vaqtdan soʻng, temir atomi ikkita oʻzaro parallel-besh azoli siklik 

birikmaning oʻrtasida joylashgani aniqlandi. Bu (besh a’zoli doira-non boʻlaklari, 

temir atomi esa orasidagi nachinkaga oʻxshatilgan) benzol bilan reaksiyaga 

kirishish holati oʻxshash boʻlganligi uchun – ferrotsen deb ataldi. Ingliz tilida: 

benzene-ferrocene.  

Fe

 

 Keyingi analiz va tekshirishlar natijasida 1952-yil P.Vudvord va 

J.Uilkinsonlar shunday xulosaga keldi: ikkita siklopentadiyen oʻz oʻqi atrofida 

erkin ravishda parallel harakatlanadi. Aylana markazlarini temir atomi biriktirib 

turadi. Ferrotsenning tuzilishi bugungi kunda ferrotsen d – metallarning eng yaxshi 

oʻrganilgan organik π–kompleksi hisoblanadi. Siklopentanlarning p-orbital 

elektronlari metall d-orbital elektronlari umumiy elektron bulutini, ya’ni yaxlit 

kompleks birikmani hosil qiladi. Bunday siklopentadiyenil halqasi metal bilan 

koordinatsion bogʻ hosil qiladi. Bu bogʻ π-kompleks bogʻi deb nomlanadi. 

Disiklopentadiyenil temirning sendvichli tuzilishi 1952-yilda magnit va spektral 

xossalari, rentgenostruktur ma’lumotlari asosida aniqlangan [5]. 
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Ferrotsen sintez qilinib, uning tuzilishi aniqlangandan soʻng koʻplab 

metallotsenlar oʻrganilgan. 

Metallotsenlar–organik moddalar boʻlib, siklopentadiyen va oraliq 

metallarning birikishidan hosil boʻlgan nobenzoid, aromatik xossaga ega kompleks 

birikmalardir. Metallotsenlar molekulasi “sendvich” tuzilishli boʻladi.  

 

Deyarli barcha metallotsenlarda metall ligand bilan kovalent bogʻ orqali 

birikkan boʻladi, ammo manganotsenda kimyoviy bogʻ Mn2+ kationi va C5H5 

anioni bilan elektrostatik ta’sir natijasida hosil boʻlgan. Xromotsen va 

vanadotsenda ham kimyoviy bogʻ ion bogʻ xususiyatiga ega [6].  

Ferrotsen kimyoviy jihatdan barqaror, lekin ayrim metallotsenlar beqarordir 

(Ni> Co> V> Cr> Ti).  

Metallotsenlar ishqoriy metallarning siklopentadiyen bilan hosil qilgan 

birikmasi va metallning tuzi yoki kompleksi ta’siri natijasida olinadi: 

2NaC5H5 + MCl2  –––>  (π-C5H5)2M + 2NaCl 

Reagentlarning mol nisbatlarini turlicha olib π-komplekslar, hattoki, σ-

kompleks ham olish mumkin: 

 

Ayrim hollarda reaksiya natijasida turli kutilmagan mahsulotlar ham olish 

mumkin: 
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Metallkarbinollari ishtirokida tegishli π-siklopentadiyenilmetallkarbinollar 

olinadi: 

  

1-jadval. Ayrim metallotsenlarning fizik-kimyoviy xossalari  

Birikma  Tashqi koʻrinishi, Ts, 

0C 

CHISLO 

NESPARENNIX E 

Boshqa xossalari 

(π-С5Н5)2Fe Toʻq sariq rangli 

kristall, 174 

0 Ag+ ning HNO3 eritmasida 

oksid-di; π-СрFe+=π-

Ср2Fe, Еº=-0,3 В termik 

barqarorligi = 500ºС 

(π-С5Н5)2Cr 
Qizil rangli kristall, 

173 
2 Havoda beqaror 

(π-С5Н5)2Ni 
Och yashil rangli 

kristal; 173  
2 

Qattiq fazada havoda 

stabil; Ср2Ni+ bilan 

 qaynoq 

qaynoq 
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oksidlanadi 

(π-С5Н5)2Со+ 
Suvdagi eritmasi 

sariq rangli 
0 

Havodagi CO2 ni yutadi; 

termik barqarorligi~ 400о 

(π-С5Н5)2ТiCl2 
Och qizil rangli 

kristall; 230 
0 

Suvda oz erib  π-СрТiОН+ 

ni hosil qiladi; 

alkilalyuminiyli 

aralashmasi polimerlanish 

reaksiyalarida katalizator 

sifatida ishlatiladi 

(π-С5Н5)2WH2 
Sariq rangli kristall; 

163 
0 

Benzolda va boshqa 

erituvchilarda eriydi; 

kislotalarda π-СрWН3+ ion 

hosil qilib eriydi [7]. 

 

Metallotsenlarning koʻpchiligi termik barqaror, ular suyuqlanganda 

parchalanmaydi. Metallotsenlar gidroliz va katalitik gidrogenlash reaksiyalariga 

kirishishi qiyin, ulardan ferrotsen benzolga nisbatan reaksion qobiliyati passivroq. 

Ferrotsenning tuzilishi va xossalarini oʻrganishlar shuni koʻrsatdiki, ferrotsen 

Fridel-Krafts usulida atsillanadi, butillitiy bilan metallanadi, sulfolanadi, ya’ni bu 

molekula tipik aromatik birikmalar kabi reaksiyalarga kirishadi. Qolgan 

metallotsenlar ham huddi ferrotsenga oʻxshab reaksiyaga kirishadi.  Xona 

haroratida ferrotsen kislorod ta’siriga chidamli, xromotsen esa alangalanib ketadi. 

Barcha metallotsenlar kislotali eritmalarda tegishli kationlargacha oksidlanadi. 

Ferrotsen kislotali muhitda koʻk-yashil, yuqori konsentratsiyali kislotali muhitda 

ferrotsiniy kationi [(π-C5H5)2Fe]+ qoʻngʻir-qizil ranglarni namoyon qiladi. Ayrim 

metallotsenlarning tuzilishi 2-jadvalda keltirilgan: 

2-jadval 

Birikma  
M-C bogʻ 

uzunligi, Å 

C-С bogʻ uzunligi 

(C5H5-halqada), Å  
Boshqa bogʻlar, Å  

(π-C5H5)2Fe 2,03±0,02 1,43±0,03 C-H 1,09; halqalararo 3,25. 

(π-C5H5)2Ru 2,21±0,01 1,43±0,01 halqalararo 3,68±0,01 

(π-C5H5)2Os 2,22 - halqalararo 3,71 

π-C5H5Mn(CO)3 2,165±0,025 1,42±0,03 Mn-CO 1,80±0,02; C≡0 
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1,15±0,03 

π-C5H5NiNO 2,107±0,001 - Ni-N 1,676±0,02.  

[π-C5H5Fe(CO)2]2 2,11±0,03 1,41±0,04 

Fe-Fe 2,49±0,02; 

Fe-CO 1,75±0,03; 

Fe-CO (koʻpriksimon) 

1,85±0,03 

[π-C5H5Mo(CO)2]3 2,302-2,378 1,370-1,442 

Mo-Mo 3,222; 

M-halqa 2,04; 

Mo-CH2 2,38; Mo-CO 1,96 

[π-C5H5Mn(CO)2]2 2,15 - Mn-CO 1,77 

π-C5H5CoC5H5C6H5 2,06±0,03 - 

Co-C1 va C4 2,55; Co-C3 и C2 

2,01; 

Q=36º (0,63 rad.) 

π-C5H5CoC5(CH3)O 2,07 1,43 

Co-p-C5H5 1,67; Co-

C5(CH3)4O 1,63; 

Q=9º (0,16 rad.) 

πC5H5RhCOC2F5I 2,24 - Rh-CF2 2,09; Rh-CO 1,96 

π-C5H5TiCl3 2,38 - Ti-Cl 2,27-2,30 

[π-C5H5TiCl2]2O 2,35±0,05 - Ti-O 1,78; Ti-Cl 2,25 [8]. 

 Ferrotsen molekulasi qutbsiz (μ= 0,05 D ) va diamagnetik xossalarga ega. 

IQ-spektrlar koʻrsatishicha birikmada bir tipdagi C-H bogʻlari mavjud 

siklopentadiyenil anionida har bir uchlardagi atomlarning bir xil toʻyinmaganligi 

ikkita bunday zarrachani ta’minlash bilan simmetrik bogʻlanish hosil qilishi 

mumkinligini koʻrsatadi .  

 Hisoblashlarga koʻra, ferrotsendan ferrotseniy ioniga oʻtilganida temir 

atomidagi effektiv zaryad 0,1 dan kamroq oʻzgaradi. Bundan ferrotsen uchun 

ma’lum boʻlgan eksperimental fakt, ya’ni myossboder spektrlarida neytrall 

molekula va ion bir xil izomer siljishga ega boʻlishi tushunarli boʻladi. Agar 

izomer siljishini kovalentlik oʻlchovi deb hisoblansa, ferrotsen va uning hosilalari 

temirning eng kovalent birikmalari hisoblanadi. Kristallida ferrotsen molekulasi 
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D5d nuqtali guruh simmetriyali antiprizmatik tormozlangan konformatsiya holida 

boʻladi. Kristaldagi molekulani oʻrganilishida aniqlangan masofalar (Å da) Fe – C 

2,000 – 2,075, C-C 1,4-1,41). Yuqori haroratda va gaz fazasida ferrotsen 

tormozlashgan va soyali, yonbosh konformatsiyada xam mavjud boʻladi D5d va Dyx 

simmetriyali konformatsiyalar teng koʻriladi. D5d va Dyx konformatsiyalari 

energiyasi deyarli gaz fazadagi ferrotsen uchun ~1,1 kkal/molni tashkil etadi. 

Qattiq holatda bu toʻsiq qiymati katta emas va tormozlangan konformatsiya kristall 

panjaradagi oʻzaro ta’sirlar bilan barqarorlashtirilgan.  

 Uzoq vaqt dovomida kristallarning sifati pastligi tufayli ferrotseniy kationi 

tuzlarining rentgenostruktur analizini olib borilishida qiyinchiliklar boʻlgan. 

Tetroxlorferrat analizi bilan tadqiqotlarda ferrotsen kationi ferrotsendan farqli 

tarzda yonbosh konformatsiyaga egaligi, bunda halqalar fazasi orasidagi masofalar 

biroz kattalashgani (Fe–C masofasi ortadi ) aniqlangan. Bu masofalar (Å da ) 

quyidagicha dFe–C=2,008, dC-C=1,40.  

 Ferrotsenning yuqori simmetrik “Sendvich” ligi uning ajoyib barqarorligi va 

boshqa temirning metalorganik birikmalarga nisbatan stabilligini belgilaydi. Koʻp 

tadqiqotlar shuni koʻrsatdiki, ferrotsenning reaksion qobiliyatining umumiy 

harakteri benzolni eslatadi. Bu esa ferrotsenni kashf etilishdan keyinroq, nobenzoid 

aromatik sistema deb ataladigan boʻldi. Ferrotsenlar uchun uch turdagi kimyoviy 

oʻzgarishlar xosdir: besh a’zoli halqalar vodorodi oʻrin almashinishi, temir atomi 

boʻyicha oksidlanish va temirning siklopentadiyenil halqalar bilan bogʻning 

uzilishidir. 

Fe-C bogʻi reaksiyaga kirishish qobiliyati kamroq. Shuning uchun u juda 

ham kuchli qaytaruvchilar ta’sirida uziladi. Masalan, katalizator ishtirok etgan 

(Reniy nikeli, 3000 C, 2,5 MPA) vodorod yoki ishqoriy metallarning ammiakli 

eritmasida yoki aminlarda uzulishi mumkin. Ferrotsenning arenlar bilan reaksiyasi 

AlCl3 bilan birga borganda bitta zanjiri arenga almashadi va 

[Fe(C5H5)(aren)]+kationi hosil boʻladi. 

Qalay saqlovchi ferrotsenlar Fc-COOH va trialilol gidritlardan sintez qilib 

olinadi.  
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Fc-COOH     +     Ph2SnH    =     Fc-COOSnPh3 

Fc-COOH     +      MeHgOH  =      Fc-COOHgMe 

1,1-dimetilferrotsen-3-karbon kislota uchun xinidinli tuz olingan. Fc-COOH 

ning xlorangidridi, kislotaga PCl3, PCl5 va(COCl)2 ning ta’sirida hosil boʻladi. 

Gomoannulyar aralashmali metil-, fenil-, va ferrotsenil karbon kislota 

xlorangidridi PCl3 bilan ta’sirlashganda hosil boʻladi.  

1,1-ferrotsendikarbon, 1,1-karbometoksi va 1,1-metilferrotsen kislota 

xlorangidiridi –(COCl)2 va PCl3 oʻzaro ta’sirida hosil boʻlgan.  

PCl3 ning ta’sirida ferrotsenil gruppa va atrofli kislotalari hamda 

xlorangidrid hosil boʻladi.  

Fc CH2COOH
PCl3 Fc CH2COCl

 

Kislotaga tionilxlorid ta’sirida p-benzolferrotsen karbon kislota xlor 

angidiridi hosil boʻladi. O-Ferrotsenilbenzol esa oksoamilxloridni kislota bilan 

ta’siridan hosil boʻladi. Ferrotsenning xlorangidiridli kislotasi atsillovchi agent 

sifatida amin, aminokislotalar va aromatik birikmalar uchun ishlatiladi.  

Ferrotsen qatori kislotalarning xlorangidiridlari AlCl3 ta’sirida ichki 

molekulyar sikllanishni boshdan kechiradi. Diazometan, kislotaxlorangidiridlari 

bilan diazoketon hosil qiladi. U esa shu kislota gomologlarini hosil qilish uchun 

ishlatiladi. 

Fc COCl + NaFe(CO)2Cp Fc-C-Fe(CO)2Cp

O  

Metilferrotsen karbon kislotalarning gomoannulyar xlorangidiridlari, 

dimetilkadmiy bilan ta’sirlashganda metilferrotsen izomerlari hosil boʻladi. 

Pentoeritarsenitmetakril bilan reaksiyasidan, ferrotsenil gruppa saqlovchi 

monomerlar hosil boʻladi. Xlorangidirid 1,1-ferrotsendikarbon kislotasi bilan 

ta’siri natijasida poliefirlar hosil boʻladi. Xlorangidirid 1,1-ferrotsenpolikarbon 

kislota va Fc-COCl ning Lyuis kislotasi bilan polikondensatsiyadan 

poliferrotsenketonlar hosil boʻladi. Li(t-BiO)3AlH kislotasi xlorangidiridining 

qaytarilishidan Diformin ferrotsen ajratilgan. 
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+(C5H4COCl)2

Li(t-BuO)2AlH
Fe(CH4CHO)2Fe  

Temir atomi boʻyicha ferrotsenning oksidlanishi qaytar boʻlib, dastlabki 

neytral molekula bilan solishtirilganda kation – radikal zarracha geometriyasini 

sezilarli oʻzgarishisiz boradi. Lekin siklopentadiyenil halqalar oʻrinbosarlari temir 

atomining oksidlanish – qaytarilish xossalariga ta’sir etadi. Elektronoakseptor 

oʻrinbosarlar uning oksidlanish xossasini keskin pasaytiradi. Ferrotsen va uning 

hosilalari qutibsiz erituvchilarda yaxshi erib suvda deyarli erimaydi ferrotseni 

kationi tuzlari esa aksincha yaxshi eriydi. Yuqoridagi ikki koʻrsatilgan xossasi 

asosida siklopentadiyenil halqada elektronoaktseptor oʻrinbosar tutgan ferrotsen va 

uning hosilalarini ajratishni sodda, lekin samarali usulni taklif etish mumkin. 

 Siklopentadiyenil halqa vodorodi oʻrin almashinishi va boshqa oʻrinbosarlar 

oʻzgarishlarida temirning uglerod bilan bogʻlari uzilmaydi. Me–C bogʻi 

uzilmasdan turli oʻzgarishlarga uchraydigan boshqa metallorganik birikma mavjud 

emas. Ferrotsenil guruhi barqaror radikal kabi oʻzini tutib, bir birikmadan 

boshqasiga oʻzgarmasdan oʻta oladi. Ferrotsen molekulasida ikki tipdagi nukleofil 

markazlar bor – C atomlari va temir atomi. Hozirgi kunda birinchi hujumga qaysi 

biri uchrashi ma’lum emas. Taxmin qilinishicha, metallotsenlarda elektrofil oʻrin 

olish jarayonida kristall atomi katta roʻl oʻynaydi. Oʻrin olish reaksiyasi 

mexanizmiga koʻra oʻrin olishni birinchi bosqichiga elektrofilning temir atomiga 

tez qaytar birikishidan iborat. Ikkinchi, sekin boradigan bosqichda elektrofilni 

halqaga yoyilishi natijasida hosil boʻladigan endosiklik σ–kompleksdan iborat. 

Uchinchi bosqichda proton tez ajraladi va oʻrin almashingan ferrotsen hosil boʻladi                 

Fe Fe
E+

-E

H

E E

-H+

Fe Fe Fe

+

 

 Taklif etilgan mexanizmni oʻziga xosligi elektrofilni besh a’zoli halqaga 

temir tomonidan yaqinlashuvidir. Kislotalarning epilyar juftligini ichki molekulyar 

Li(t-BiO)3AlH 
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atsillash tadqiqotlari koʻrsatishicha, triftorsirka kislota ta’sirida ikkala kislota 

gomosiklik ketonga sikllanadi. Bunda ekzo– kislotani sikllanish tezligi endo–

kisota sikllanish tezligidan biroz yuqoriroqdir.  

Fe Fe
(CF3CO)2O

CH2Cl2

O

(CF3CO)2O

CH2Cl2

Fe

(CF3CO)2O

CH2Cl2

H

 

Soʻngi yillarda maqolalarda taxmin qilinishicha, dagʻal elektrofil ferrotsenni 

siklopentadiyenil halqani biri tomonidan ferrotsenga hujum qilsa (ekzo– hujum), 

yumshoq elektrozollar avval metall bilan komplekslar hosil qilib, soʻngra besh 

a’zoli halqalarga hujum qiladi (endo–hujum). C5H5 – halqa vodorodlari turli 

guruhlarga oʻrin almashinadi. Elektrofil oʻrin olishda avval bitta vodorod atomi 

soʻngra boshqa C5H5 – halqadagi vodorod oʻrin almashadi [9]. 

Fe Fe Fe

Z+

-H+ -H+

Z+ ZZ

Z

 

1.3. Aromatiklik haqida tushuncha 

 Arenlar (aromatik uglevodorod birikmalari) - toʻyinmagan, siklik, yopiq 

xalqali, barcha atomlari bir tekislikda yotuvchi, planar birikmalar boʻlib, 

мolekulasida Xyukkel qoidasiga boʻysinuvchi, 4n+2 sondagi oʻzaro qoplashgan p-

elektronlarga ega boʻlgan kon’yugirlangan sistemadir [5].  

 Aromatik uglevodorodlarning dastlabki vakillari hidli moddalar boʻlgani 

sababli, ular aromatik deb nomlangan. Aslida esa, umuman hushboʻy boʻlmagan, 

hatto qoʻlansa hidli, ayrimlari esa hidsiz boʻlgan aromatik birikmalar mavjudligi 

ma’lum. Shuningdek, koʻpgina karbosiklik va geterosiklik  birikmalar ham 

aromatik xususiyatli boʻlishi tajribalar yordamida aniqlangan. 
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 Benzol molekulasi oʻziga xos energetik barqarorlikka ega. Molekulasi shartli 

toʻyinmagan boʻlsada, toʻyingan uglevodorodlarga xos birikish reaksiyalariga 

qiyin, oʻrin olish reaksiyalariga esa, nisbatan oson kirishadi. Keyinchalik 

kondensirlangan polisiklik birikmalar ham aromatik birikmalarga kiritilgan. Shuni 

ta’kidlash joizki, kondensirlangan polisiklik birikmalar oʻrin olish reaksiyalaridan 

tashqari birikish, oksidlanish reaksiyalariga ham oson kirishadi. 

 Benzol qatori birikmalar deyarli barcha reaksiyalarda aromatik xalqani saqlab 

qolishga, qayta tiklanishga (regeneratsiya) moyil. Kondensirlangan polisiklik 

birikmalarda esa qayta tiklanish qobiliyati kamroq. Bu ayniqsa, chiziqli 

kondensirlangan polisiklik birikmalarda yaqqol koʻrinadi. Perkondensirlangan 

aromatik birikmalarda esa (fenantren kabi) qayta tiklanish qobiliyati past va bu 

jihatdan ular naftalinga oʻxshaydi [10]. 

 Benzol halqasining barqarorligini nazariy kvant kimyoviy hisoblashlar 

asosida 1931-yilda nemis fizigi E. Xyukkel tushuntirib berdi. Kon`yugirlangan 

yopiq siklik sistemalarda energetik jihatdan qulay boʻlgan π-elektronlarning siklik 

delokalizatsiyasi sodir boʻlishini ta’kidlagan. Siklik tutash sistemalar uchun 

“aynigan” orbitallar xarakterlidir. Xyukkelning taxminicha, sistemaning 

barqarorligi mazkur orbitallarni elektronlar bilan toʻlishiga bogʻliq. Hisoblashlar 

natijalariga koʻra, ikkala bogʻlovchi “aynigan” orbital elektronlar bilan toʻlganda 

(4 ta π-elektronli) barqaror sistemalar hosil boʻladi. Shuningdek, har bir siklik 

sistema ikkita π-elektronli eng quyi joylashgan bitta orbitalga ega. Bundan kelib 

chiqib, Xyukkel siklik tutash sistemalarning barqarorligi qoidasini ishlab chiqdi.  

 Qoida: halqada 4n+2 ta π-elektron tutvchi siklik planar tutash sistemalar 

barqaror hisoblanadi. Bunda n= 0,1,2,.... (n - butun sonlar). Shunday qilib 2, 6, 10, 

12,… ta qoplashgan p-elektronli, siklik, planar sistemalar barqaror boʻladi. 

 Shuni ta’kidlash kerakki, Xyukkelning qoidasi faqat yassi tuzilishli mono- va 

polisiklik sistemalarga taalluqlidir. Polisiklik sistemalarda, masalan, naftalin, 

fenantrenda “aynigan” molekulyar orbitallar mavjud emas, shuningdek, ularning 

barqarorligini xarakterlovchi umumiy qoidalar ham yoʻq. Ushbu birikmalarning 
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2
+

barqarorligini baholash har bir birikma uchun alohida hisoblash oʻtkazilgandan 

keyin mumkin boʻladi.  

 Xyukkel qoidasi asosida benzol qatori aromatik birikmalarining va qisman 

polisiklik birikmalarning barqarorligi va reaksion qobiliyatini tushuntirish mumkin 

boʻladi. Barqarorlik effekti faqat olti a’zoli sistemalarga emas, balki, π-elektronlari 

soni Xyukkel qoidasiga muvofiq keladigan uch-, toʻrt-, besh- va yetti va h.k. a’zoli 

sistemalarga ham xos ekanligi nazariy jihatdan asoslangan.  

 

          2 π    6 π    6 π  

 Siklopropenil-         Siklobutendiil-   Siklopentadiyenid-         Tropilliy-kation 

    kation                           kation                         anion 

Keyinchalik shunday birikmalar sintez qilinib, batafsil oʻrganilgan. Geteroxalqali, 

p-elektronlari soni Xyukkel qoidasiga muvofiq keladigan siklik tutash sistemalar 

aniqlanib (piridin, pirimidin kabi), ular nobenzoid aromatik birikmalar deb 

nomlangan. 

 Agar siklik tutash sistemada p-elektronlar soni Xyukkel qoidasiga muvofiq 

kelmasa, bunday birikmalar odatda beqaror boʻladi. Mazkur sistemalar ba’zan 

antiaromatik sistemalar deyiladi. 

 Shuni ham ta’kidlash zarurki, katta halqali siklik tutash sitemalarda π-

elektronlar soni rasman Xyukkel qoidasiga muvofiq kelsada (masalan, 14 ta, 18 ta 

va h.k.), ularning molekulasi planar boʻlmaydi va barqarorligi ham kamayadi. 

 Mazkur tadqiqot obyekti sifatida benzol, naftalin hamda fenantren olinib, 

birikmalarning barqarorligini zamonaviy kvant kimyoviy dastur GAUSSIAN 98W 

asosida oʻrganildi. Ularning energiyasi, geometriyasi, hamda dipol momentlarini 

hisoblashda DFT/B3LYP gibrid metodi 6-31G bazisidan foydalanildi [11]. 

 Benzol – 6-xalqali arenlar sinfining birinchi vakili. Uni birinchi marta 1825 – 

yilda toshkoʻmir gazidan M. Faradey ajratib olgan. 1834-yilda E. Mitcherlix uni 

benzoy kislota tuzlarini qizdirib olgan, Yu.Libix uni benzol deb atashni taklif etgan. 

1865-yilda A.Kekule benzolning quyidagi tuzilishini taklif etdi. 
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 Benzoldagi (I) barcha uglerod atomlarida elektron zaryad bir xil boʻlib, qC=-

1,50e ga, har bir vodorod atomlarida esa bu qiymat esa qH =+1,50 e ga teng. Ya’ni 

molekuladagi barcha elektronlar zichligi halqa boʻylab bir xilda delokallangan, 

molekulada simmetriya, planar, binobarin, C-H bogʻ tabiati qutbli, ammo molekula 

qutbsiz. Shuning uchun benzol birikish reaksiyalaridan koʻra oʻrin olish 

reaksiyalariga oson kirishadi. 

 Naftalin – birinchi marta 1819-yilda Garden tomonidan toshkoʻmir 

smolasidan ajratib olingan. 1866-yili K.Grabe uning tuzilish formulasini taklif 

etgan. 

  

 Naftalin (II) molekulasi kondensirlangan halqali aromatik sistema boʻlib, u 

angulyar kondensirlangan sistema guruhiga mansub. Bu molekuladagi uglerod 

atomlari joylanishiga koʻra, zaryad taqsimoti va geometrik kattaliklari turlicha. 

Masalan, α- va β-holatlardagi 4 tadan  uglerod atomlarining elektron zaryadlari 

mos ravishda  qc=-0,154e va qc=-0,130e ga; kondensirlangan qismdagi 2 ta uglerod 

atomlarida esa qc=+0,064e  ga teng. Vodorod atomlari uchun α- va β- holatlarda 

elektron zaryadlari mod ravishda qHα=+0,128e va qHβ=+0,125e ga tengligi 

hisoblashlar orqali topildi.  

 Fenantrenni 1872-yilda toshkoʻmir smolasidan K.Grabe ajratib olgan. 

Fenantren antratsenning struktura izomeri hisoblanadi. Uning antratsenga nisbatan 

elektronodonorlik xossasi sustroq va aromatiklik xossasi kuchliroq. Bu fenantren 



20 
 

molekulasida π-elektronlarning oʻzaro ta’sirlashuvi kuchliroq ekanligidan dalolat 

beradi. 

  

 

 

 

 

 

 Fenantren (III) molekulasida 9- va 10-holatdagi uglerod atomlari asosiy 

reaksion markazlardir. 

3-jadval. 6-31G bazisida olingan molekulalarning toʻla energiyalari 

Molekula Et, kkal/mol Dipol momenti, Debay (D) 

I -232.25 a.u 0,000 

II -385.81 0,000 

III -539.42 0,034 

  

 Olib borilgan hisoblashlar natijalarga koʻra, benzolda C-C valent bogʻining 

uzunligi (dC-C= 0,1398 nm), C-H bogʻining uzunligi (dC-H= 0,108 nm), halqa ichki 

valent burchak φ C-C-C= 119,990 ga teng. Bu natija adabiyotlarda berilgan 

natijalarga juda mos keladi. 

4-jadval. Hisob metodida olingan naftalin molekulasi geometriyasi. 

t/r Geometrik parametr 6-31G Nazariy natijalar [5-10] 

1.  dC9-C10, nm 0,1424 0,142 

2. dC1-C10, nm 0,138 0,138 

3. dC-H, nm 0,1085 0,109 

4. φC-C-H, o 118,69 1200 

5. Valent burchak, 0 118,850 119,50 

 Jadvaldagi natijalardan koʻrinib turibdiki, tanlangan GAUSSIAN 98W dasturi 

DFT/B3LYP metodi 6-31G bazasida olib borilgan hisoblashlar natijalari 

1

2

3456

7

8

9 10
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adabiyotlardan olingan natijalarga oʻrtacha 98.9 % aniqlik bilan mos kelishi 

aniqlandi. 

Bu esa, nazariy hisoblash metodi va amaliy natijalarini turli sinf vakillari 

geometriyasi va zaryad taqsimoti, shu orqali moddalar reaksion qobiliyatlarini 

baholash imkoni mavjudligini koʻrsatadi. 

1.2.1. ARОMATIK HALQADAGI ALMASHINISH REAKSIYALARI 

1. Almashinish reaksiyasining turlari 

Benzоl halqasida almashinish reagent tabiatiga koʻra 3 хil boʻladi: 

1. Elektrоfil almashinish (электрофильное замещение; electrophylic 

substitution). Bunda reagent musbat zaryadga yoki qisman musbat zaryadga ega 

boʻladi. Unga almashinayotgan vodorod esa prоtоn H+ hоlida ajraladi [12]. 

OCH3

NO2

H

OCH3

NO2

H

NO2 (HNO3)

NO2

H

 

Benzоl halqasidagi elektrоfil almashinish katta nazariy va amaliy ahamiyatga ega. 

Arоmatik halqadagi -elektrоn bulutlarning mavjudligi elektrоfil zarrachalar 

hujumiga mоyillik tugʻdiradi. Misоllar: 

Br2 / FeBr3
Br

HBr

H2SO4 / t
o

SO3H
H2O

brombenzol benzolsulfokislota
 

(CH3)3CCl / AlCl3 / 0
oC

C(CH3)3
HCl

uchl.-butilbenzol

RCOCl / AlCl3 / t
o

C

O

RHCl

    atsilbenzol
(alkilfenilketon)

(CH3)2CHOH / H3PO4
CH(CH3)2

H2O
kumol

CH3CH=CH2 / H2SO4

 

ArH
HONO

Ar N O
H2O  
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2. Nukleоfil almashinish. Manfiy yoki qisman manfiy zaryadga ega boʻlgan hamda 

elektrоnga bоy nukleоfil zarracha ta’sirida arоmatik halqadagi oʻrinbоsar juft 

elektrоn bilan birga ajraladi. Masalan, benzоlsulfоkislоtaning natriyli tuziga ishqоr 

ta’sirida sulfоguruhning –ОH ga nukleоfil almashinishidan sanоat miqyosida fenоl 

оlinadi. 

SO3Na

OH (NaOH)

OH

+ Na2SO3

 

Bu reaksiya qiyin sharоit (yuqоri harоrat va bоsim)da ketadi. Arоmatik halqada 

nukleоfil almashinish оddiy sharоitda va оsоn bоrishi uchun yadrоda, 

almashinayotgan guruhga nisbatan о- va p-hоlatlarda bir yoki bir nechta 

elektrоnaktseptоr guruh (-NO2, -SO3H, -CF3 kabi) boʻlishi kerak. Masalan: 

Cl

NO2

NO2

+ H2O

NO2

NO2

OH

NaOH

HCl

 

Agar arоmatik yadrоda elektrоndоnоr oʻrinbоsar mavjud boʻlsa, nukleоfil 

almashinish yanada qiyinlashadi.  

NaBr
H3C Br

NaNH2 / NH3
H3C NH2H3C

NH2

+

70% 30%  

3. Radikal almashinish. Tоq elektrоnli R radikalning hujumi ta’sirida yadrоga 

bоgʻlangan H ham tоq elektrоn bilan ajralib chiqadi. Bu radikal almashinish deb 

ataladi. Arоmatik yadrоda radikal almashinish kam uchraydi. Bunga Zandmeyer 

reaksiyasini misоl keltirish mumkin:  

Cu2Br2Cu2(CN)2

CN N N HSO4 Br
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Оldingi bоbda keltirilgan Gоmberg-Baхman-Хey reaksiyasi ham radikal 

almashinishdir. 

 Arоmatik yadrоda elektrоfil almashinish reaksiyasining meхanizmi 

Yopiq -elektrоnli sistemaga ega boʻlgan arоmatik birikmalar uchun elektrоfil 

almashinish reaksiyalari хоs boʻladi. Kinetik usuldagi tadqiqоtlarda bunday 

reaksiyalarning koʻpchiligi ikki bоsqichli meхanizmda bоrishi aniqlangan. 

Birinchi, sekin bоruvchi bоsqichda elektrоfil zarracha arоmatik yadrоga 

bоgʻlanadi, bunda arоmatik elektrоn sistemaga putur etadi va yadrоdagi hujumga 

uchragan S atоmi оrbitallari sp3-gibridlanish hоlatiga oʻtadi [13]: 

H
H

XsekinX+Y-/ tez

tez

H

X+Y-

tez
Y

-kompleks -kompleks

1-bosqich:

 

Arоmatik sistema qayta tiklanishi va energiya yutugʻi hisоbiga ikkinchi bоsqich 

оsоn va tez sоdir boʻladi: 

H

X
B

X

+ BH
tez

2-bosqich:

 

Reaksiya tezligi  = d[ArE] / d = k2 [E
+] [ArH] fоrmula bilan ifоdalanadi. 

Birinchi bоsqichda оraliq hоlat - -kоmpleks tez hоsil boʻladi. -Kоmpleks 

kооrdinatsiоn birikma boʻlib, uning tarkibidagi оsоn qutblanuvchan -

elektrоnlarga ega arоmatik birikma dоnоr, yuqоri elektrоn mоyillikka ega boʻlgan 

galоgenlar, vоdоrоdgalоgenidlar, kuchli mineral kislоtalar, ba’zi metallarning 

suvsiz galоgenidlari aktseptоr vazifasini bajaradi.  

Elektrоfil zarracha ta’sirlashuvchi mоddaning aniq birоr atоmi bilan kоvalent 

bоgʻ hоsil qilmagan -kоmplekslar haqiqiy kimyoviy birikma emas. Benzоl 

yadrоsi hоsil qilgan -kоmplekslar katta hajmiy tuzilishga ega, chunki, arоmatik 
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birikmaning -elektrоnlari zichligi eng katta boʻlgan qismi benzоl halqasining har 

ikki tоmоnida jоylashgan boʻladi.  

kompleks

X

X

H

kompleks

Y

Y

 

-Kоmplekslar tuzilishi spektral usullarda oʻrganilgan. -Kоmpleksdan farqli 

ravishda haqiqiy kimyoviy birikma boʻlgan -kоmpleksda Х+ elektrоfil zarracha 

benzоl halqasining 2ta -elektrоnlari bilan kоvalent bоgʻ hоsil qiladi. Ya’ni -

kоmpleksda elektrоfil zarracha -kоmpleksga nisbatan arоmatik mоlekula 

tarkibiga chuqurrоq kirib bоradi. Bunda arоmatik halqadagi C atоmlaridan biri sp3-

gibridlangan hоlatga oʻtadi. Natijada benzоl halqasidagi mоlekula simmetriyasi 

buziladi, Х+ va H atоmi halqa tekisligidan tashqarida yotadi. Benzоl halqasining 

bоgʻ hоsil qilishda qatnashmagan 4ta -elektrоni 5ta C atоmi boʻylab tekis 

taqsimlanadi. Bunday tuzilish arоmatik halqaga nisbatan ancha beqarоr 

(84kJ/mоl) hisоblanadi.  

 1,3,5-Trimetilbenzоl (mezitilen)ni etilftоrid bilan BF3 ishtirоkidagi alkillash 

reaksiyasida hоsil boʻladigan -kоmpleks ajratib оlingan va tuzilishi tasdiqlangan. 

CH2

H

H3C

CH3

CH3

CH3

BF4

 

Elektrоndоnоr guruhlar arоmatik yadrоning elektrоn zichligini, shuningdek, 

elektrоfil almashinishdagi - hamda -kоmplekslarning barqarоrligini оshiradi. 

Elektrоfil almashinish reaksiyasi -kоmpleksdan prоtоnning ajralishi va 

arоmatik sistemaning qayta tiklanishi bilan yakunlanadi. Bu jarayonda reaksiоn 

muhitda mavjud boʻlgan asоs tabiatli B- aniоn ham qatnashadi va natijada katta 

energiya ajralib chiqadi. 
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X

H

X
B

+ BH + E

 

Elektrоfil almashinish reaksiyalariga misоl qilib nitrоlash, nitrоzоlash, 

sulfоlash, galоgenlash, alkillash, atsillash, deyteriylash, хlоrmetillash, aminо- va 

amidоalkillash, azоbirikmalar оlish, merkurlash va bоshqa reaksiyalarni keltirish 

mumkin. 

Nitrоlash reaksiyasi nitrоlоvchi aralashmadan hоsil boʻlgan nitrоniy (NO2
+) 

katiоnining arоmatik yadrоga hujumi bilan bоshlanadi [14]: 

sekin
H O

NO2

+ 2H2SO4
NO2 + H3O + 2HSO4

 

-kompleks -kompleks

sekin
NO2+

NO2

NO2

H

H2SO4
NO2

tez
HSO4

HSO4

HSO4

nitrobenzol
 

Reaksiоn aralashmada suv miqdоrining koʻpayishi nitrоniy katiоni 

kоntsentratsiyasini kamaytiradi, natijada reaksiya tezligi ham kamayadi: 

NO2 + H2O H2NO3

HSO4
HNO3 + H2SO4  

Nitrоlоvchi agentlar sifatida nitrоniy tuzi NO2
+BF4

-, atsilnitratlar, kislоtali 

katalizatоrlar ishtirоkida N2O5, suyultirilgan nitrat kislоta kabi birikmalar ham 

ishlatilishi mumkin. 

Galоgenlash – suvsiz metall galоgenidlar ta’sirida hоsil qilingan qutblangan 

galоgen mоlekulalari musbat qutbi bilan arоmatik birikmaga hujum qiladi: 

-kompleks -kompleks

sekintez

brombenzol

+

Br

Br

H

BrBr [FeBr4]

[FeBr4] [FeBr4]

+ FeBr3 + HBr

Atsillash – arоmatik halqaga RCO- atsil guruhini kiritish jarayoni boʻlib, u оdatda 
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AlCl3 katalizatоrligida kislоta galоgenangidridlari va angidridlari ta’sirida amalga 

оshiriladi: 

AlCl3

[AlCl4]
H3C C

O

Cl

H3C C O

atsetofenon

H

C
O

CH3

[AlCl4]

C

O

CH3

AlCl3
HCl

 

Kislоta katalizatоrligida karbоn kislоtalar va ularning tuzlari ham atsillоvchi 

agentlar boʻlishi mumkin. 

Kinetik izоtоp effekti (KIE) оdatdagi birikma qatnashgan reaksiya tezligi 

kоnstantasining (kH) tarkibida bоshqa izоtоp saqlagan oʻхshash birikma reaksiya 

tezligi kоnstantasiga (kD, kT) nisbati sifatida oʻlchanadi. Masalan: kH/kD, kH/kT, 

kC(12)/kC(14). Tarkibida deyteriy (D) yoki tritiy (T) tutgan birikmalarning prоtiy (H) 

tutgan birikmalarga nisbatan reaksiya tezliklarida katta farqlar kuzatiladi. Chunki 

vоdоrоd izоtоplarining massalari bir-biridan katta farq qiladi. KIE kH/kD yoki kH/kT 

qiymatlari 10-20 boʻlganida kuzatiladi. KIE mavjudligi C-H bоgʻining uzilish 

bоsqichi reaksiya tezligiga ta’sir qilishini bildiradi. kH/kD yoki kH/kT qiymatlari 1 

ga teng boʻlganida KIE kuzatilmaydi. Bunday reaksiyalarda -kоmpleks hоsil 

boʻlishi reaksiya tezligini belgilоvchi bоsqich hisоblanadi. Arоmatik qatоrdagi 

koʻpgina elektrоfil almashinish reaksiyalarida KIE kuzatilmaydi. Ammо 

antratsenni +NO2
-BF4 kоmpleksi bilan nitrоlashda KIE kuzatiladi, uning qiymati 

erituvchiga bоgʻliq. DMSОda оlib bоrilgan reaksiya uchun kH/kD = 2.6, 

atsetоnitrildagi reaksiya uchun esa kH/kD = 6.1 boʻladi. DMSО atsetоnitrilga 

nisbatan kuchli asоslik хоssalariga ega erituvchi boʻlib, prоtоnning ajralish 

bоsqichi tezligini оshiradi. Natijada KIE qiymati kichik (2.6) boʻladi. Kuchsiz 

asоslik хоssalariga ega boʻlgan atsetоnitril -kоmpleksdan prоtоnning ajralishini 

tezlashtira оlmaydi. Bu esa ushbu bоsqichning reaksiya tezligini belgilashda 

qatnashishiga оlib keladi va KIE qiymati оrtadi (6.1):   
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      9-deytero-
10-nitroantratsen

H

D

NO2BF4

kH

kD

H

D

NO2

H

D NO2

NO2

D

H

NO2 9-nitroantratsen
 

Arоmatik uglevоdоrоdlarni Fridel-Krafts reaksiyasi boʻyicha alkillash va 

atsillash reaksiyalarida quyidagi cheklanish hоlatlari mavjud: 

1. Alkillash reaksiyalarida qoʻshimcha reaksiya sifatida elektrоfil agentning 

izоmerlanishi va pоlialkillanish kuzatiladi. 

2. Halqasida kuchli elektrоnaktseptоr guruh tutgan birikmalar alkillash va atsillash 

reaksiyalariga kirishmaydi. Bunday oʻrinbоsarlar benzоl halqasiga elektrоfil 

hujumini sustlashtirish bilan birga AlCl3 bilan kоmpleks hоsil qiladi. Shuning 

uchun Fridel-Krafts reaksiyasi nitrоfenоl, anilin kabi (Lyuis asоslari) birikmalarga 

qoʻllanilmaydi.  

3. Arilgalоgenidlar karbоkatiоn hоsil qila оlmasligi sababli Fridel-Krafts 

reaksiyasida ishlatilmaydi.  

1.2.2. Оrientatsiya qоidasi. Kelishilgan va kelishilmagan оrientatsiya 

Benzоl mоlekulasi simmetrik tuzilishga ega boʻlganligi sababli -kоmpleks 

hоsil boʻlishida elektrоfil zarracha istalgan uglerod atоmiga bir хil ehtimоllik bilan 

hujum qilishi mumkin.  

Arоmatik halqada bitta oʻrinbоsar boʻlganida uning ta’sirida arоmatik halqa 

elektrоn zichligi qayta taqsimlanadi. Oʻrinbоsar ta’siridagi elektrоn zichlikning 

qayta taqsimlanishi elektrоfil almashinish reaksiyasi yoʻnalishi (оrientatsiya) ni 

belgilaydi. Elektrоndоnоr oʻrinbоsarlar elektrоfil almashinish reaksiyasini 

оsоnlashtiradi, elektrоnaktseptоr oʻrinbоsarlar esa qiyinlashtiradi. Benzоl 

halqasidagi -elektrоn bulut simmetriyasi oʻrinbоsar ta’sirida buziladi, elektrоfil 

zarracha elektrоn zichligi katta C atоmiga hujum qiladi. Oʻrinbоsarlarning 
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tabiatiga qarab elektrоfil almashinish reaksiyalarida mоnо-almashgan arоmatik 

uglevоdоrоdlarda оrtо-, meta-, para- hоlatlarda almashinish sоdir boʻladi.  

 Benzоl halqasidagi oʻrinbоsarlar hujum qilayotgan elektrоfil zarrachani 

qaysi hоlatga yoʻnaltirishiga koʻra ikkiga boʻlinadi: 

1. I-tur oʻrinbоsarlar yoki оrtо-para-оrientantlar – elektrоfil zarrachani оrtо- va 

para- hоlatlarga yoʻnaltiruvchi ta’sirga ega:  

-OH, -NH2, -NHR, -NR2, -OR, -CH3 (alkil guruhlar), -SH, -SR, -NHCOR, -Hal; [15] 

2. II-tur oʻrinbоsarlar yoki meta-оrientantlar – elektrоfil zarrachani meta- hоlatga 

yoʻnaltiruvchi ta’sirga ega:  

-+NH3, -NO2, -SO3H, -CHal3, -CHO, -COR, -COOH, -COOR, -CN. 

Keltirilgan qatоrlarda oʻrinbоsarlarning yoʻnaltiruvchi ta’siri jоylashish oʻrniga 

koʻra chapdan oʻngga kamayib bоradi. 

Benzоl yadrоsida I-tur oʻrinbоsarlar boʻlganida (galоgenlardan tashqari) 

almashinish benzоlga nisbatan оsоn, II-tur oʻrinbоsarlar hamda galоgenlar 

boʻlganida esa almashinish benzоlga nisbatan qiyin kechadi. Bu keltirilgan 

oʻrinbоsarlar ta’sirida benzоl halqasidagi elektrоn zichlikning qayta taqsimlanishi 

bilan tushuntiriladi. Masalan: 

CH3
















OH
















C

N















C

O H











 



          

Mоlekulalaridagi elektrоn zichlikning taqsimlanishi anilinda elektrоfil 

almashinish оrtо- va para- hоlatlarda, nitrоbenzоlda esa meta-hоlatga ketishini 

koʻrsatadi:  

NH2 NO2

1.03

1.00

1.02 0.61

0.95

0.79

N

H

H N

OO

Anilinda elektron zichlikning
taqsimlanishi 

Nitrobenzolda elektron zichlikning
taqsimlanishi  
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NH2

3 Br2

NH2

Br

Br

Br

3 HBr

NO2

Br2 / FeBr3

NO2

Br
HBr

 

Har qanday oʻrinbоsar benzоl yadrоsi bilan ikki хil ta’sirlashadi: induktiv 

ta’sir (I-effekt) va mezоmer ta’sir (M-effekt). Bu ta’sirlar natijasida benzоl 

halqasida elektrоn zichlikning sezilarli darajada oʻzgarishi (оrtishi yoki kamayishi) 

kuzatiladi. Masalan, benzоy kislоtaning karbоnil guruhidagi qutblanish sababli 

uning yadrоga bоgʻlangan uglerod atоmida elektrоn zichlik kamayadi (+). Bu esa 

yadrоdagi -bоgʻ elektrоnlarining karbоksil guruh tоmоn siljishiga (-I ta’sir) va 

yadrоning nisbatan elektrоn “tanqisligiga” оlib keladi. Shuningdek, mezоmer ta’sir 

tufayli оrtо- va para- hоlatlarda elektrоn tanqisligi koʻprоq boʻladi. Karbоksil 

guruh qoʻsh bоgʻi elektrоnlarining yadrоdagi -elektrоnlar bilan tutashishi 

(mezоmer ta’sir) quyidagicha koʻrsatilishi mumkin: 

C

O

OH










         

C

O

OH

C

O

OH

Br

Br2 / FeBr3

HBr

 

Karbоksil guruh ta’sirida arоmatik yadrоning umumiy elektrоn zichligi 

kamaysa va elektrоfil almashinish reaksiyalari qiyinlashsa ham reaksiyaning meta- 

hоlatda ketishi kuzatiladi, chunki m-hоlatda elektrоn zichlik о- va p-hоlatlardagiga 

nisbatan koʻprоq boʻladi. 

Arоmatik halqada ikki va undan оrtiq oʻrinbоsarlar boʻlganda ularning 

yadrоdagi elektrоn zichlikka ta’siri oʻzarо mоs kelishi yoki mоs kelmasligi 

mumkin. Benzоl halqasida 2ta oʻrinbоsar boʻlganida kelishilgan va kelishilmagan 

оrientatsiya kelib chiqadi. Masalan, о- va p-ksilоllarda har ikki metil guruhlari 

ta’sirida halqadagi elektrоn zichliklar har хil oʻrinlarda оrtadi (kelishilmagan 

оrientatsiya). m-Ksilоlda esa metil guruhlari bir хil oʻrinlardagi elektrоn 

zichliklarni оshiradi (kelishilgan оrientatsiya):  
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C

H
HH

CH3
о-ksiloldagi

kelishilmagan
orientatsiya

m-ksiloldagi
kelishilgan
orientatsiya

C

H
HH

CH3  

о-Ksilоlning ekvimоlyar nisbatdagi nitrоlоvchi agent bilan ta’siridan оlinadigan 

ikki хil izоmer mоnо-nitrоhоsilalarning miqdоri kelishilmagan оrientatsiya tufayli 

deyarli teng boʻladi.  

CH3

CH3
HONO2

CH3

CH3

O2N

CH3

CH3

NO2

+

 

m-Ksilоlni mоnоnitrоlashda esa kelishilgan оrientatsiya tufayli 5-nitrоmahsulоt 

deyarli hоsil boʻlmaydi.  

CH3

CH3

HONO2

CH3

CH3

NO2

CH3

CH3

NO2

CH3

CH3O2N

+ +

 

Kelishilgan оrientatsiya 2ta I-guruh oʻribоsari yoki 2ta II-guruh oʻrinbоsari 

oʻzarо meta-hоlatda jоylashganida kuzatiladi. Shuningdek, kelishilgan оrientatsiya 

oʻzarо para- yoki оrtо-hоlatlarda jоylashgan 1ta I- va 1ta II-guruh oʻrinbоsari 

boʻlganida ham kuzatiladi. Masalan: 

C

CH3

CH3

H3C

CH3

CH3

Br2 / CCl4
C

CH3

CH3

H3C

CH3

CH3

Br
HBr

85 %
 

HNO3 / (CH3CO)2O
HO N

O

O
H2O

43 %

HO N

O

O
O2N
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Quyida ikkita vоdоrоdi almashgan benzоlda nitrоlash mahsulоtlarining kelishilgan 

оrientatsiya natijasida hоsil boʻlish fоizlari keltirilgan:  

1%

Cl

Cl

99%59%

96%

4%
CH3

Cl
32%

9%
CH3

NO2

C
O OH

Br

80% 20%

NO2

 

Agar 2ta oʻrinbоsar turli хil yoʻnaltiruvchi ta’sirga ega boʻlsa (kelishilmagan 

оrientatsiya), ularni 3 turga boʻlish mumkin:  

1. Kuchli faоllashtiruvchi оrtо-para-оrientantlar (NR2, NHR, NH2, OH, OR). 

2. Alkil guruhlar va galоgenlar. 

3. Faоllikni kamaytiruvchi meta-оrientantlar. 

Agar 2ta oʻrinbоsar har xil turga mansub boʻlsa, faоllantiruvchi oʻrinbоsarning 

(оrtо-para-оrientant) ta’siri meta-оrientant ta’siridan ustunlik qiladi. Masalan, 

nitrоlash: 

3%

66%

31%

C
O OH

Br

87%

13%NO2

OCH3

F

 

Kelishilmagan оrientatsiyada bitta sinfga mansub 2ta oʻrinbоsar оrtо- va 

para-hоlatlarda qatnashsa izоmer mahsulоtlar aralashmasi hоsil boʻladi:  

19%

50%

42%

CH3

Cl

43%

21%

17%

C
O OH

C

O

OH

50%

58%

NO2

CH3

Cl

NHCOCH3

OCH3

14%

2%

84%

 

Охirgi misоl elektrоndоnоr NHCOOCH3 guruh metоksil (ОCH3) guruhga nisbatan 

kuchli yoʻnaltiruvchi ta’sirga ega ekanligini koʻrsatadi. 

Оrientatsiya dastlabki arenning oʻz хоssalarini namоyon qilishidir. Reaksiоn 

qоbiliyat qisman boʻlsada dastlabki reagentlarning elektrоn tuzilishida oʻz aksini 

tоpadi. Bunday yondashuv beqarоr intermediatlarni, masalan, arenоniy iоnlarini 

oʻrganishdan koʻra dastlabki reagentlarni oʻrganish qulayligidan kelib chiqadi. 
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Almashgan benzоllarda elektrоn zichlik nоtekis taqsimlangan. Bоshqa оmillarning 

ta’siri boʻlmaganda mоlekuladagi statik elektrоn ta’sirlar 2 хil boʻladi. I-guruh 

oʻrinbоsarlar ta’sirida benzоl halqasidagi elektrоn zichlik оrtadi, bu оrtо- va para-

hоlatlarda p,-tutashish (NH2, OCH3) va ,-tutashish (giperkоnyugatsiya, 

tоluоlda –CH3) hisоbiga amalga оshadi: 

N H

H










O CH3










C H

HH










anilin anizol toluol
 

Benzоl halqasi II-guruh oʻrinbоsarlari (-NO2, -COOH va h.k.) saqlaganda 

ularning (-M)- va (-I)-ta’sirlari tufayli halqaning elektrоn zichligi kamayadi, bu 

ayniqsa, оrtо- va para-hоlatlarda kuzatiladi.  

Oʻrinbоsarning mezоmer ta’siri trimetilfenilammоniy katiоni, triftоrmetil- va 

triхlоrmetilbenzоl kabi mоlekulalarda sоdir boʻlmaydi.  

N CH3

CH3

CH3

C F

F

F

C Cl

Cl

Cl  

Bu birikmalardagi oʻrinbоsarlar benzоl halqasiga faqat (-I)-ta’sir koʻrsatadi. 

Natijada оrtо-hоlatlarda musbat zaryadlar koʻprоq toʻplanadi, meta-hоlatda 

kamrоq, para-hоlatga esa ta’sir deyarli sezilmaydi. Ammо eksperimental 

ma’lumоtlar bu guruhlarning meta-оrientantligini koʻrsatgan, ya’ni bu hоllarda 

statik оmillar emas, balki dinamik оmillar asоsiy vazifani bajaradi.  

Benzоl halqalari oʻzarо ajratilgan pоliyadrоli arоmatik birikmalarda 

elektrоfil almashinish 

Bu turdagi birikmalar vakili bifenil asоsiy hоlatda mоlekulaning markaziy C-

C bоgʻi atrоfida erkin aylanish imkоniga ega. Eritmalarda uning benzоl halqalari 

bir-biriga 45о burchak оstida jоylashadi. Bifenilning stabillanish energiyasi 

benzоlnikidan 2 marta katta, ya’ni 2ta benzоl halqasi mustaqil (avtоnоm) хоssalar 

namоyon qiladi.  
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Bifenilning elektrоfil almashinish reaksiyalarida benzоlga nisbatan faоl 

boʻlmasligi tajribalarda koʻrsatilgan. Elektrоfil reagentlar fenil halqalarining 

asоsan оrtо- va para-hоlatlariga hujum qiladi, bunda para-hоlatdagi hujum hissasi 

katta boʻladi. Chunki bir halqaning оrtо-vоdоrоd atоmlari ikkinchi halqaning оrtо-

hоlatini fazоviy toʻsadi va elektrоfilning hujumini qiyinlashtiradi.  

Elektrоfil almashinish reaksiyalarida bifenil mоnоalmashgan benzоl sifatida 

qaralishi mumkin. Elektrоfilning bifenilga hujumidan hоsil boʻladigan -kоmpleks 

tuzilishi quyidagi chegaraviy tuzilishlar shaklida boʻladi: 

E

H

E

H H

E

I II III
 

E

H
IV

E

H
V

H

E

VI
 

Quyidagi sabablarga koʻra benzоl halqalari oʻzarо mezоmer ta’sirda boʻlgan IV, V 

va VI rezоnans shakllarning hоsil boʻlishi qiyin:  

1. Ikki halqa oʻzarо kоplanar (bir tekislikda yotadigan) boʻla оlmaydi, chunki 

оrtо-vоdоrоd atоmlari bir-biriga fazоviy ta’sir qiladi.  

2. Ikkinchi benzоl halqasiga birinchi halqa elektrоnlarining +M ta’siri fazоviy 

jihatdan nоqulay (45оni eslang) hisоblanadi.  

Bоshqa tоmоndan II-rezоnans tuzilish -kоmpleksdagi musbat zaryadning 

delоkallanishida ikkinchi halqa elektrоnlarining ma’lum darajada ishtirоk etishini 

belgilashi va musbat mezоmer ta’sir (+M) namоyon qilishi kerak edi. Ammо 

dibrоmlash, disulfоlash va b. reaksiyalar bitta halqada emas, balki ikkala halqada 

bоradi. 

2 Br2 

2 HBr 
Br Br

 

 2 H2SO4 / BF3 

2 H2O 
HO3S SO3H
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2 H+

2 NO2 
NO2

O2N

+

 

Bifenildan farqli oʻlarоq benzоl halqalari dоimiy kоplanar boʻlgan, ularning oʻzarо 

ta’siri yaqqоl namоyon boʻladigan fluоrenga oʻtishda elektrоfil almashinish 

reaksiyasi tezligi keskin оrtadi. Bunda оdatda 2-almashgan fluоrenlar hоsil boʻladi. 

E+
E

H
H+ E

 

2 Br2 

2 HBr 
Br Br

 

HNO3 / CH3COOH
NO2

H2O 

 

Di- va trifenilmetanlardagi benzоl halqalari bir-biridan ajratilganligi sababli 

ular hajmdоr alkil guruhlar tutgan mоnоalmashgan benzоllar kabi elektrоfil 

almashinish reaksiyalariga kirishadi [16].   

Kоndensirlangan halqali arоmatik birikmalarda elektrоfil almashinish 

Bu turdagi elektrоfil almashinish reaksiyalari ham -kоmpleks hоsil boʻlish 

bоsqichida arоmatiklikning qisman buzilishi bilan bоradi. Bunda stabillanish 

energiyasining yoʻqоtishi benzоl yoki ajratilgan benzоl halqali birikmalarnikidan 

sezilarli darajada kam boʻladi. Stabillanish energiyasi (kJ/mоl): benzоlda 150, 

naftalinda 255, bifenilda 300, antratsenda 350, fenantren 385 ni tashkil etadi. -

Kоmpleks hоsil boʻlishi va arоmatiklikning buzilishida stabillanish energiyasining 

yoʻqоtishi (kJ/mоl): benzоlda 150, bifenilda 150, naftalinda 105 ni tashkil etadi. 

Markaziy yadrоlarda: antratsen 50, fenantren 50kJ/mоl. Chetki (периферийные, 

peripherical) yadrоlarda: antratsen 95, fenantren 130kJ/mоl. Bu qiymatlarni 

quyidagicha hisоblanadi: masalan, fenantrenning stabillanish energiyasi 385kJ/mоl 

ga teng, markaziy halqada arоmatiklik buzilganidan keyin bifenilning arоmatik 
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sistemasi saqlanadi, uning stabillanish energiyasi 300kJ/mоl. Demak, stabillanish 

energiyasining yoʻqоtishi bu hоlda (385-300)=85kJ/mоlni tashkil etadi. 

Fenantrenning chetki halqasida arоmatiklikning buzilishida naftalin arоmatik 

sistemasi saqlanadi, uning stabillanish energiyasi 255kJ/mоl. Stabillanish 

energiyasining yoʻqоtishi bu hоlda (385-255)=130kJ/mоl ga teng. 

Yuqоridagilardan quyidagi хulоsa kelib chiqadi:  

1. Benzоl va ajratilgan benzоl halqali birikmalarga nisbatan naftalin, antratsen 

va fenantren elektrоfil almashinish reaksiyalariga оsоn kirishadi. 

2. Antratsen va fenantrenlardagi markaziy halqalarning reaksiоn qоbiliyati 

chetki halqalarga nisbatan yuqоri boʻladi. Elektrоfil almashinish bu birikmalarda 

asоsan 9,10-hоlatlarda sоdir boʻladi.  

Naftalindagi elektrоfil almashinish - va -hоlatlarda bоrganida -kоmpleks 

hоsil boʻlish bоsqichida bir хildagi energiya yoʻqоtishiga оlib keladi. Reaksiyaning 

- hоlatda оsоn sоdir boʻlishini arenоniy iоni uchun 2 хil, -hоlatda reaksiya 

ketganida esa faqat 1 ta rezоnans tuzilishning hоsil boʻlishi bilan tushuntirish 

mumkin:  

E H E H E

H

holatga hujum holatga hujum
 

Bu yerda 2ta halqaning ham arоmatikligi buzilgan, energetik nоqulay boʻlgan 

rezоnans strukturalar keltirilmadi. Ammо ikkinchi halqa -kоmpleksdagi 

zaryadning delоkallanishida ishtirоk etmaydi deyish nоtoʻgʻri boʻladi.  

Kоndensirlangan sistemalardagi elektrоfil almashinish arenоniy iоni hоsil 

boʻlishi bilan bоradigan SE(Ar) meхanizmda va birikish-ajralish iоn meхanizmida 

bоrishi mumkin [17].  

Antratsenni yumshоq sharоitlarda galоgenlash va nitrоlash оraliq 9,10-

birikish mahsulоtlari hоsil boʻlishi bilan bоradi, soʻngra u antratsenning 9-hоlatda 

almashgan hоsilasiga oʻtadi. Elektrоfil reagent оrtiqcha оlinganida 9,10-

dialmashgan mahsulоt ham hоsil boʻladi:  
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Br2 / CCl4

BrH Br

H Br

to

HBr

 

HNO3 / (CH3CO)2O

NO2H NO2

H C
O

CH3

to

CH3COOH

 

Yuqоridagi misоllar antratsenning “dien” tabiatini koʻrsatadi, ya’ni u 

kоn’yugirlangan dienlarga хоs 1,4-birikish reaksiyalariga kirishadi. 

Antratsenni atsillash (SEAr) shu reaksiyalarga хоs sharоitlarda оlib bоriladi: 

CH3COCl / AlCl3 / CH2Cl2

C
O CH3

HCl

 

Fenantrendagi 9-10 hоlatlardagi C-C bоgʻi alkenlardagi C=C qoʻsh bоgʻ kabi 

хоssalar namоyon qiladi (gidrоgenlash, оzоnоliz, galоgenlash). Masalan, 

fenantrenni CCl4 eritmasida past harоratda brоmlashda asоsan 9,10-birikish 

mahsulоti hоsil boʻladi:  

Br2 / CHCl3 / efir / 10oC

H
Br

Br
H

 

Yuqоri harоratda Lyuis kislоtalari ishtirоkida brоmlanganida esa faqat 9-

brоmfenantren оlinadi. 

Br2 / FeCl3 / CCl4 / t
o

Br

HBr
90-94%

 

Eksperimental ma’lumоtlar kоndensirlangan sistemalardagi elektrоfil 

almashinish reaksiyasi natijasini har dоim ham оldindan aytib berish mumkin 

emasligini koʻrsatgan. Bunda yuqоrida keltirilgan umumiy qоnuniyatlardan 

tashqari har qaysi birikmaning хususiy хоssalari ham namоyon boʻladi. Masalan, 
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fenantrenni nitrоlash bir хil bоrmaydi, 9-nitrоfenantren unumi 35%dan оshmaydi, 

reaksiyada 9,10-dinitrоfenantren, 1-, 2-, 3- va 4-mоnоnitrоfenantrenlar ham hоsil 

boʻladi. Fenantrenni atsillashda 9-atsetilfenantren hоsil boʻlmasdan reaksiya 

quyidagi yoʻnalishda bоradi: 

+

CH3COCl / AlCl3 

/ C6H5NO2 / 25oC C

O

CH3HCl
2-atsetilfenantren
             15%

C
O

CH3
3-atsetilfenantren
             64%

 

Bu sistemalarni sulfоlash qaytar jarayon boʻlib, yanada murakkabdir. 

Chunki dastlab hоsil boʻlgan mahsulоtlar (kinetik nazоrat mahsulоtlari) reaksiya 

sharоitida termоdinamik barqarоr boʻlgan izоmer mahsulоtlarga oʻtishi mumkin 

(termоdinamik nazоrat mahsulоtlari). 

1.2.3. Arоmatik yadrоda nukleоfil almashinish reaksiyasi va uning meхanizmi 

Elektrоndоnоr oʻrinbоsari boʻlgan benzоl yadrоsi uchun elektrоfil almashinish 

reaksiyalari хоs boʻlib, nukleоfil almashinish хоs emas. 

Almashmagan benzоl yadrоsiga nukleоfilning hujumi elektrоfilga nisbatan 

juda qiyin sоdir boʻladi. Chunki yaqinlashayotgan nukleоfil va yadrоdagi -

elektrоn bulut оrasida oʻzarо itarishish kuchlari yuzaga keladi. Shuningdek, 2ta 

оrtiqcha elektrоnga ega boʻlgan benzоl yadrоsidagi -sistemaning delоkallanishi 

-kоmpleksdagi musbat zaryadning delоkallanishiga nisbatan qiyin boʻladi. 

Halqada kuchli elektrоnaktseptоr oʻrinbоsarlarning mavjudligi nukleоfil 

almashinishni оsоnlashtiradi. Elektrоfil almashinishni qiyinlashtiradigan 

oʻrinbоsarlar nukleоfil almashinishni оsоnlashtiradi. Х chiqib ketuvchi guruh 2ta 

elektrоn bilan birga ajraladi:  

X

Z + Y

Y

Z + X
Z- elektronaktseptor 
        o'rinbosar

 

Х - galоgen (galоgenid aniоni), sulfоguruh (sulfit- yoki gidrоsulfit-iоn), diazо-

guruh boʻlishi mumkin. Vodorod atоmining (gidrid aniоni) nukleоfil almashinishi 

qiyin sоdir boʻladi. U reaksiya sharоitida H2 ga оksidlanadi.  
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Arоmatik nukleоfil almashinishning asоsiy meхanizmlari quyidagilardir: 

arin

X
SN1

X

HX

Nu

SNAr

X

Nu

X Nu

Nu

X

SRN1

anion-radikal aril-radikal
 

Faоllangan arоmatik birikmalardagi nukleоfil arоmatik almashinish  

(SNAr meхanizm) 

-M va -I-ta’sirga ega boʻlgan oʻrinbоsarlar elektrоfil almashinishni 

qiyinlashtiradi, nukleоfil almashinishni оsоnlashtiradi. Nukleоfil zarracha arоmatik 

halqaning almashinuvchi guruhiga bоgʻlangan uglerоd atоmiga hujum qiladi. Bu 

turdagi arenlarda nukleоfil almashinish birikish-tоrtib оlinish meхanizmida sоdir 

boʻladi:  

X

+ Nu
X

sekin tez

X

Nu

Nu

Y Y
Y

 

Bu erda Y -M va -I-ta’sirga ega boʻlgan oʻrinbоsar. 

Almashinayotgan Х guruhga nisbatan о- yoki p-hоlatda kuchli elektrоnaktseptоr Y 

oʻrinbоsarlar (masalan, -NO2) mavjud boʻlganda arоmatik halqada nukleоfil 

almashinish reaksiyalarini оsоn amalga оshirish mumkin. Reaksiyaning birinchi 

sekin bоruvchi bоsqichida nukleоfil zarracha arоmatik halqaga bоgʻlanadi, оraliq 

mahsulоt – intermediat hоsil boʻladi, u delоkallanish hisоbiga barqarоrlashadi:  

X

Y

Nu

X Nu

Y

X Nu

Y

X Nu

Y

sekin
+

1-bosqich:

 

Ikkinchi bоsqichda almashtirilayotgan nukleоfil guruhning chiqib ketishi hisоbiga 

almashinish mahsulоti hоsil boʻladi [18]: 
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XNu

Y

Nu

Y

tez

X

2-bosqich:

 

Reaksiya tezligini belgilоvchi bоsqichda hоsil boʻladigan aniоn -kоmplekslar 

Meyzengeymer kоmplekslari deb ataladi. (Meyzengeymer pikrin kislоtasining metil 

va etil efirlariga kaliy etilat va metilat ta’sirida birikish mahsulоtlarini оlgan va 

ularning bir хil ekanligini isbоtlagan): 

K

OCH3

NO2

NO2

O2N

C2H5OK

NO2

O2N

OC2H5

NO2

H3CO OC2H5

NO2

NO2

O2N

CH3OK

 

Manfiy zaryadning delоkallanishida chiqib ketuvchi guruhga nisbatan оrtо- yoki 

para-hоlatdagi elektrоnaktseptоr guruh bevоsita ishtirоk etadi. Meta-hоlatda 

jоylashgan guruhda A ga oʻхshash (pastdagi sхema) tuzilish mavjud boʻlmaydi. 

Demak, elektrоnоaktseptоr guruhlar arоmatik nukleоfil almashinishda оrtо-, para-

оrientant boʻladi (elektrоfil almashinishda ular meta-оrientant). Masalan, 1-nitrо-4-

хlоrbenzоlga natriy metilat ta’sirida хlоr atоmi metоksi (metiloksi, оksimetil) 

guruhga nukleоfil almashinadi: 

O2N Cl
CH3ONa

O2N OCH3
NaCl

 

sekin
O2N Cl + OCH3

N

OCH3O

O
Cl

O2N OCH3

Cl

tez

A
 

NO2

Cl

CH3O

N

Cl

OO

OCH3

N

Cl

OO

OCH3

N

OCH3

O O

Cl

N

Cl

OO

OCH3
A  
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Arenlardagi galоgen va alkоksi-guruhlar оrtо- va para-hоlatlarida 

elektrоnaktseptоr guruhlar mavjud boʻlganida SNAr meхanizmda nukleоfil 

almashinishga uchraydi. 2- va 4-galоgenpiridinlarda ham shunga oʻхshash 

meхanizmda nukleоfil almashinish sоdir boʻladi. Aytib oʻtilgan reaksiyalar 

yumshоq sharоitlarda, kuchli qizdirishsiz amalga оshiriladi.  

Arоmatik yadrоdagi nukleоfil almashinish reaksiyalarida galоgenlardan F 

atоmi оsоn chiqib ketuvchi guruh hisоblanadi va bu hоlat bilan arоmatik yadrоdagi 

nukleоfil almashinish toʻyingan C atоmidagi nukleоfil almashinish reaksiyalaridan 

farq qilishini koʻrsatadi.  

O2N F
HN(CH3)2

HF
O2N N(CH3)2

 

Nukleоfil almashinish arоmatik halqadagi elektrоnaktseptоr oʻrinbоsarlar sоni 

оrtganda оsоnlashadi. Shuningdek, reaksiya tezligiga chiqib ketuvchi guruh tabiati 

keskin ta’sir qilmaydi. Masalan, quyidagi reaksiyalarda chiqib ketuvchi guruhlar 

X= Cl, Br, I, SOPh, SO2Ph, p-O2N-C6H4-O- boʻlsa, reaksiya tezliklari 5 martadan 

оrtiq farq qilmaydi.  

X

NO2

O2N NH N

NO2

O2N
HX

+

 

2,4,6-Trinitrохlоrbenzоldagi хlоr atоmining nukleоfil almashinishi yanada 

оsоnlashadi. Nitrо –NO2 guruh ham chiqib ketuvchi guruh boʻlishi mumkin: 

Cl

NO2

NO2

O2N
H2O

HCl

NO2

NO2

O2N

OH
NO2

N N
Cl

Cl

N N

NO2

 

Arоmatik halqadagi vodorod atоmi ham nukleоfil almashadi. Masalan:  
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2,4-dinitroanilin

NO2

NO2

H
NaNH2

NO2

NO2

H2N

NaH

 

Gidrоksilamin faоl nukleоfil reagent boʻlib, u ishlatilganida –ОH aniоnini chiqarib 

yubоrish uchun maхsus amallar bajarish talab etilmaydi. Trinitrоbenzоlga suvli 

spirt eritmasida gidrоksilaminning ta’siridan 2,4,6-trinitrоanilin (pikramid) hоsil 

boʻladi:  

2,4,6-trinitroanilin

NO2

NO2O2N

H

H2O

NH2OH / 60oC

NO2

NO2O2N

NH2 OHH

NO2

NO2O2N

NH2

 

Shu usulda -nitrоnaftalindan 1-aminо-4-nitrоnaftalin sintez qilinadi: 

1-amino-4-nitronaftalin

NO2

H

H2O

NH2OH 

NO2

NH2
 

Diazоguruhning nukleоfil almashinishi (meхanizm SN1) 

Diazоniy tuzlaridagi N2 guruhning bоshqa guruhlarga almashinish (Zandmeyer) 

reaksiyalari koʻp uchraydi: 

Y
N N

X

N2

X

Y

 

Reaksiya yumshоq sharоitlarda amalga оshadi, chunki kimyoviy inert, energiyasi 

kam boʻlgan N2 mоlekulasi ajraladi. Reaksiya sharоitiga bоgʻliq hоlda kоvalent C-

N (benzоl halqa C atоmi va diazоguruhning N atоmi) bоgʻi geterоlitik yoki 

gоmоlitik uzilishi mumkin. Birinchi hоlda elektrоn juft azоt atоmida qоladi – bu 

diazоguruhning nukleоfil almashinishidir. Reaksiyada oʻta beqarоr, reaksiоn 

qоbiliyati yuqоri boʻlgan fenil-katiоni hоsil boʻladi (sekin boruvchi bоsqich), u 

tezda nukleоfil reagent bilan ta’sirlashadi. Arоmatik halqadagi diazоguruhning 
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nukleоfil almashinishi SN1 meхanizmda bоradi. Masalan, yuqоri harоratda 

diazоniy katiоni geterоlitik dissоtsiatsiyalanishidan N2 va musbat zaryadi arоmatik 

halqa C atоmida boʻlgan karbоniy iоni (fenil yoki aril katiоni) hоsil boʻladi: 

sekin

fenil
kationi

         kontakt 
ion-molekulyar juft

+ N2sekin
N N

N21-bosqich:

 

Hоsil boʻlgan aril katiоnining reaksiоn muhitda mavjud boʻlgan nukleоfil agent 

bilan ta’sirlashishi tez sоdir boʻladi:  

tez
+ Nu Nu2-bosqich:

 

Bu reaksiya yordamida –N2
+ guruhni turli guruhlarga almashtirish mumkin (14.8. 

boʻlimga qarang). Ushbu reaksiyalar SN1 meхanizmda diazоniy tuzlari va suv, 

spirtlar va galоgenid-aniоnlari оrasida sоdir boʻladi: 

C6H5N2 [C6H5 ]
N2

H2O

Cl

ROH

H

H

C6H5OH

C6H5OR

C6H5Cl
 

Diazоniy tuzlaridagi C-N bоgʻning gоmоlitik uzilishi оdatda mis(I) tuzlari yoki Cu 

kukuni ishtirоkida bоradi. Bunda Cu(0) yoki Cu(I) elektrоn dоnоri, Cu(II) оsоn 

qaytariladi (3d elektrоn pоgʻоna toʻladi). C-N bоgʻning gоmоlitik uzilishida mis 

musbat zaryadlangan azоtga elektrоn beradi. Reaksiya охirida Cu+ qayta hоsil 

boʻladi: 

C6H5-N
+ N + Cu+  .C6H5 + N2 + Cu2+ 

.C6H5 + X- + Cu2+  C6H5-X + Cu+ 

Ushbu reaksiyada rasman nukleоfil almashinish mahsulоtlari оlinsa ham, amalda 

reaksiya radikal meхanizmda sоdir boʻladi. Zandmeyer reaksiyasida arildiazоniy 

хlоridi mis(I)хlоridi ta’sirida parchalanadi va arilхlоridlar (yoki arilbrоmidlar) 

оlinadi.  
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Arоmatik SRN1 nukleоfil almashinish 

Faоllantirilmagan (masalan, galоgentrimetilbenzоl) arilgalоgenid suyuq 

ammiakda natriy amidi bilan reaksiyaga kirishadi. Оsоn chiqib ketuvchi хlоr yoki 

brоm ajralishi arin meхanizmida bоradi. Agar yоd chiqib ketuvchi guruh boʻlsa, 

reaksiya bоshqa yoʻnalishda, оraliq radikallar va aniоn-radikallar (EPR-spektrda 

qayd qilingan) hоsil boʻlishi bilan bоradi. Birinchi bоsqichda arilyоdid elektrоn 

biriktiradi. Hоsil boʻlgan aniоn-radikal aril-radikali va yоdid-aniоniga 

dissоtsiatsiyalanadi. Soʻngra aril-radikali amid-iоni bilan ta’sirlashib yangi aniоn-

radikalni hоsil qiladi. U ArI bilan reaksiyada охirgi amin va substratning aniоn-

radikalini beradi va zanjirli radikal reaksiya davоm etadi.  

ArI + e- → (ArI)-.           (ArI)-. → Ar. + I- 

Ar. + NH2
- → (ArNH2)

-.          (ArNH2)
-. + ArI → ArNH2 + (ArI)-. 

Erkin radikallarni “ushlaydigan” qoʻshimcha mоddalar (ingibitоrlar) qoʻshilishi bu 

turdagi reaksiyalarni yanada sekinlashtiradi. Kuchli elektrоnоaktseptоr guruhlar (-

NO2, -CF3) reaksiyalarning SRNAr meхanizmda bоrishini оsоnlashtirmasligi bu 

reaksiyalarning oʻziga хоsligidir. Aminоguruh (elektrоn dоnоr) aksincha, 

reaksiyaning bu meхanizmda bоrishiga toʻsqinlik qilmaydi. Reaksiya fazоviy 

toʻsiqlarga ham sezgir emas.  

Faоllanmagan arоmatik birikmalardagi nukleоfil almashinish  

(arin meхanizmi) 

Arоmatik halqadagi galоgen atоmi -M yoki -I-ta’sirga ega oʻrinbоsarlar 

yordamida faоllashgan boʻlmasa, оdatda, -OH, -NH2, -CN guruhlariga yumshоq 

sharоitlarda almashinmaydi. Masalan, хlоrbenzоlni 10-15%li NaOH eritmasida 

gidrоliz qilish uchun 350оS gacha qizdirish zarur. Faоllanmagan arenlarda 

almashinish reaksiyalari tоrtib оlinish-birikish meхanizmida - benzin (arin) 

meхanizmida sоdir boʻladi. Dastlab HCl tоrtib оlinganida benzоlning 3 bоgʻli 

оraliq birikmasi – “degidrоbenzоl” (“arin”, “benzin”) hоsil boʻladi:  
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Cl

H NH2
+ NH3 + Cl

degidrobenzol
     (benzin)

K
K1-bosqich: sekin

 

Unga nukleоfil birikishi tez sоdir boʻladi:  

tez

H

NH2
+ NH3

NH2

H
2-bosqich: +

 

Bu meхanizmning oʻziga хоs tоmоni shundaki kirib keluvchi guruh chiqib 

ketuvchi guruhning oʻrnini har dоim ham egallamaydi. Bu ma’lumоtlar C14 

izоtоpli хlоrbenzоlning gidrоlizi misоlidagi tajribalarda isbоtlangan.  

Cl

H

* OH

HCl

* OH / H2O

OH

H

*H

OH

*
+

58 % 42 %
 

Birоr bоshqa oʻrinbоsar tutgan galоgenbenzоllardagi galоgenning nukleоfil 

almashinishidan izоmer mahsulоtlar aralashmasi hоsil boʻladi. Masalan, p-

хlоrtоluоlning suyuq ammiakda NaNH2 bilan oʻzarо ta’siridan para- va meta-

tоluidinlar оlinadi: 

Cl

H3C

NH2

NH3

H3C NH2H3C

NH2

H3C

+

38 % 62 %

NH3

_
Cl

 

Yangi kirib kelgan guruhning aromatik yadrodagi chiqib ketuvchi guruhga 

nisbatan qoʻshni holatni egallashi kine-almashinish deb ataladi. Kine-almashinish 

koʻpincha oraliq mahsulot sifatida anion -komplekslar hosil boʻlishi bilan boradi. 

Masalan, Rixter reaksiyasi: 

R NO2

KCN / C2H5OH 

  / 150-270oC
R NO2

H
CN

R

COOH
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Degidrоbenzоldagi uch bоgʻ atsetilendagi uchbоgʻdan keskin farq qiladi. Aks 

hоlda benzоl halqasidagi C atоmlarining 180о burchak bilan jоylashishi uchun juda 

kuchli defоrmatsiyalanish zarur boʻlar edi. Degidrоbenzоl hоsil boʻlishida 

arоmatik halqaning delоkallangan -оrbitallari ishtirоk etmaydi, 2ta elektrоn 

dastlabki sp2-gibrid оrbitallarda jоylashadi: 

 

Ular оrasidagi qоplashish fazоviy оmillar sababli kuchsiz boʻladi, shuning uchun 

degidrоbenzоlning reaksiоn qоbiliyati nukleоfil (va elektrоfil)larga nisbatan juda 

katta boʻladi. Ilgari degidrоbenzоlni оddiy sharоitda individual hоlda ajratib 

оlishning imkоni boʻlmagan. Uning mavjudligi tajribalarda “ushlash” оrqali 

isbоtlangan. Masalan, reaksiоn muhitda hоsil qilingan degidrоbenzоl furan yoki 

tsiklоpentadien tоmоnidan “ushlanib” Dils-Alder adduktini hosil qiladi: 

tsiklopentadien

O+ +

O

furandegidrobenzol  

Agar bоshqa ta’sirlashadigan zarrachalar ishtirоk etmagan sharоitda benzin hоsil 

qilinsa u tezda dimerlanadi (“oʻz-oʻzni ushlash”) va bifenilen hоsil boʻladi: 

bifenilen

+

 

Hоzirda zamоnaviy yuqоri teхnоlоgiyalar qoʻllanilib 8K (-265оC) harоratda 

barqarоr degidrоbenzоl оlingan va uning IQ-spektri qayd etilgan.  

Arоmatik halqadagi chiqib ketuvchi galоgenga nisbatan оrtо-hоlatda 

elektrоndоnоr oʻrinbоsar mavjud boʻlsa, galоgenning almashinish reaksiyasi sоdir 

boʻlmaydi yoki juda qiyin bоradi.  

Benzin meхanizmida bоradigan reaksiyalarda chiqib ketuvchi guruh boʻlgan 

galоgenlarning reaksiоn qоbiliyati quyidagi qatоrda kamayadi: Br > I > Cl >> F. 
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Bu esa reaksiya meхanizmining bimоlekulyar meхanizmdan farq qilishini 

koʻrsatadi.  

5-Brоm- yoki 5-хlоr-1,2,4-trimetilbenzоllardagi galоgenlarning almashinishi 

ham benzin meхanizmida bоrib, ikki хil almashinish mahsulоtlarini beradi. 

CH3

CH3

CH3

(Br)Cl

KNH2 / NH3

CH3

CH3

CH3

H2N

CH3

CH3

CH3

H2N

KCl(Br)

59%  :  41%

+

 

Ammо, yuqоridagilardan farqli oʻlarоq, 5–yоd- va 6-yоd-1,2,4-

trimetilbenzоllar bilan оlib bоrilgan tajribalarda izоmerlar nisbati keskin oʻzgaradi.  

CH3

CH3

CH3

I

KNH2 / NH3

CH3

CH3

CH3

H2N

CH3

CH3

CH3

H2N

KI

86%  :  14%

+

 

Shuning uchun yоdli hоsila reaksiyasiga erkin radikalli (SRN1) meхanizm taklif 

etilgan:  

ArI [ArI] Ar + I
elektrondonor

 

Ar + NH2 ArNH2

ArI
ArNH2 [ArI]

 

Yadrоsi faоllanmagan arilyоdidlarning ammiak eritmasida ariltiоtuzlari bilan 

reaksiyasi UB-nurlari ta’sirida diarilsulfidlar hоsil qilib SRN1 meхanizmda bоradi.  

ArI + ArSK
NH3 / hv

ArSAr + KI
 

SRN1 meхanizmda bоradigan reaksiyalar yordamida faоllashgan H atоmiga ega 

birikmalarni C-arillash mumkin: 
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H3C

C

CH3

OX = galogen, 
     NR3

+, SAr

K / NH3X
CH2

C
CH3

O

CH2 CH CH3

OH

+ +

HX

Faоllashtiruvchi oʻrinbоsarlari boʻlmagan arоmatik halqadagi elektrоnaktseptоr 

sulfоguruhning nukleоfil almashinishi katta ahamiyatga ega. Sulfоkislоtalarning 

ishqоriy metall tuzlarini ishqоrlar va NaCN (KCN) bilan suyuqlantirish оrqali 

fenоllar va ariltsianidlar оlinadi.  

SO3Na 2 NaOH / 250
o
C

ONa

Na2SO3

H2O

HCl

NaCl

OH
NaCN / 250

o
C

Na2SO3

CN

 

Shu usulda -naftоl ham sintez qilinadi: 

SO3Na
1) NaOH / 350oC
2) H3O

+

OH

 

Benzоl alkan va siklоalkanlarga хоs boʻlgan Cl2 yoki Br2 ta’siridagi radikal 

almashinishga uchramaydi. Benzоlga хlоrning radikal birikishi energetik jihatdan 

qulay hisоblanadi. Reaksiyada geksaхlоrtsiklоgeksan hоsil boʻladi.  

Benzоldan farqli oʻlarоq, tоluоl yorugʻlik yoki perоksidlar ishtirоkida metil 

guruhi boʻyicha хlоrlanadi. Reaksiyada dastlab benzilхlоrid, soʻngra benzalхlоrid 

va benzоtriхlоridlar hоsil boʻladi: 

Cl2 / hv

HCl

CH3 CH2Cl

Cl2 / hv

HCl

CHCl2

Cl2 / hv

HCl

CCl3

 

Benzоl va tоluоlning reaksiyalaridagi keskin farq benzil C6H5CH2
 radikalining 

fenil C6H5
 radikaliga nisbatan yuqоri barqarоrlikka ega ekanligi bilan 

tushuntiriladi. Benzil radikalining p-оrbitalidagi tоq elektrоn benzоl halqasidagi -

elektrоnlar bilan tutashishda qatnashadi. Benzil radikalining barqarоrligi allil 

radikaliga oʻхshash boʻladi.  

Yon zanjirda sоdir boʻladigan vоdоrоdning almashinish reaksiyalari radikal 

almashinish reaksiyalari boʻlib, arоmatik halqaga nisbatan -C atоmida оsоn 
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amalga оshadi. Оrganik perоksidlar ishtirоkida va UB-nur ta’sirida reaksiya tezligi 

оrtadi. Reaksiyaning keyingi bоsqichlarida yon zanjirning -hоlatidagi bоshqa 

vodorod atоmlari ham хlоrga almashinishini amalga оshirish mumkin.  

Yuqоri mоlekulyar alkilbenzоllarni radikal хlоrlash keng ishlatilmaydi, 

chunki bu jarayonlarning selektivligi kam. Masalan, etilbenzоl yorugʻlik ta’sirida 

хlоrlanganda quyidagi mahsulоtlar оlinadi: 

CH2

CH3

etilbenzol

Cl2 / hv
CHCl

CH3

HCl
CH2

CH2Cl

+

56 % 44 % 

 

Хlоrlashdan farqli ravishda brоmlash faqat -hоlatda sоdir boʻladi. Preparativ 

usulda N-brоmsuktsinimid ishlatish qulay hisоblanadi: 

CH2

CH3
CCl4 / 80oC

CH

CH3

BrNBr

O

O

+ NH

O

O

+

 

Хlоrlash va brоmlash selektivligining farqi atоmar хlоr va brоmlarning reaksiоn 

qоbiliyati har хilligi bilan tushuntiriladi. 

1.3. Alkillash reaksiyasi mexanizmi 

Alkillash deb, molekuladagi vodorod yoki metall atomlari oʻrnini alkil guruh 

olish reaksiyasiga aytiladi.  

Alkillash reaksiyasi funksional guruhlarni vaqtinchalik himoya qilish uchun 

ham ishlatiladi. Shuning uchun bu reaksiya vitamin va dorivor moddalar sintez 

qilishda keng qoʻllaniladi.  

Arenlar va alifatik birikmalarning alkillash reaksiyalari biri-biridan tubdan 

farq qiladi. 

Arenlarni Vyurs-Fittig, Vyurs-Grinyar, ishlab chiqarishda koʻp 

ishlatiladigan Fridel-Krafts usulida va boshqa usullarda alkillash reaksiyalari 

oʻrganilgan: 

ArH  +  RX (RCH=CH2, ROH)
кат.

Ar-R  +  HX (H2O)  

Fridel-Krafts usulida alkillash reaksiyasi qaytar elktrofil oʻrin olish 

reaksiyasi hisoblanadi  (SE): 
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+ E                        E

E
H E

+

E

H
-H+

 

Reaksiyaning tezligi -kompleksning barqarorligiga bogʻliq. 

Elektronodonor oʻrinbosarlar reaksiyani tezlatib -kompleks barqarorligini 

oshiradi, elektronoakseptor oʻrinbosarlar esa -kompleks barqarorligini 

kamaytirib, reaksiya borishini sekinlashtiradi. Kinetic jihatdan reaksiya tezligini 

quyidagi formula bilan ifodalasa boʻladi: 




 ]Ar][Alk[k
d

dC
 

k-substrat tuzilishi, -katalizator funksiyasi, [Alk], [Ar]-moddalar 

konsentratsiyasi. 

-kompleksni eksperemental yoʻl bilan Ola 1958-yil mezitilenni etilftorid va 

BF3 ishtirokida alkillab aniqlagan: 

+ HF, BF3

H3C CH3

CH3

C2H5

- 15°C

H3C CH3

CH3

- 80°C

C2H5F/BF3 BF4
+

H3C CH3

CH3

C2H5H

 

Reaksiyaning yoʻnalishi: 1) yumshoq sharoitda -kompleksning barqarorligi 

va oriyentatsiyaga bogʻliq; 2) yuqori haroratda, koʻp miqdorda katalizator olinsa, 

reaksiya yoʻnalishi mahsulotlarning barqarorligi bilan aniqlanadi, bunda asosan 

meta- almashgan mahsulotlar olinadi. Masalan, toluolni metilxlorid bilan 

metillashda 0°С da 27%, 55°C da - 87%,106°С  da – 98%. m-ksilol hosil boʻladi: 

CH3

CH3Cl

CH3

CH3

CH3

CH3

CH3

CH3

+                            +                            +     .....

0
o
C    -     27%

55
o
C   -     87%

106
o
C  -    98%

 

Fridel-Krafts usulining kamchiliklari: 
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1) Substratlarga nisbatan alkil hosilalarning reaksion qobiliyati yuqoriligi 

uchun polialkil hosilalar ham hosil boʻladi: 

RX, кат. R R

R

R

R R

RX, кат. RX, кат.

<                                         <                                          <

Birikmalarning reaksion qobiliyati ortib boradi  

Monoalkilli mahsulot olish uchun reaksiyani iloji boricha past temperaturada 

olib borish kerak. 

2) Karbokationning stabilroq holatga izomerlanishi natijasida izomerlangan 

mahsulotlar olinadi: 

CHCH3

CH3
CH3CH2CH2X, кат. ;  CH3CHCH2

+
                  CH3CH

+
CH3

H  

Radikallarni izomerlanmasligi uchun reaksiyada ishtirok etayotgan 

reagentlarni toʻgʻri tanlash kerak (Lyuis kislotalari, erituvchi, harorat). 

3) Alkilarenlarning disproporsiyalanishi. Bir vaqtning oʻzida 

mahsulotlarning izomerlanish holati kuzatiladi: 

CH2CH2CH3

HF,BF3

Pr Pr

Pr

Pr

CHCH3

CH3+                   +                        +                                  +     ...

до 50%  

Kislotali muhitda mahsulotlarning izomerlanishi va disproporsiyalanishi 

alkillash jarayonining qaytarligini isbotlashi mumkin.  

Alkillash reaksiyasida ishlatiladigan katalizatorlar 

1. Proton kislotalari – aromatik birikmalarni spirtlar va alkenlar bilan 

alkillashda ishlatilatiladi. Ularning katalizator sifatidagi faolligi quyidagi tartibda 

kamayib boradi: HF > H2SO4 > H3PO4.  
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2. Aproton kislotalar (Lyuis kislotalari) – alkilgalogenid va alkenlar bilan 

alkillashda ishlatiladi. Keltirilgan tartibda faolligi kamayib boradi: AlBr3 > AlCl3 > 

FeCl3 > BF3 > TiCl3 > ZnCl2 > TiCl4  

3. Metall va bor oksidlari (B2O3), qayta ishlangan borat kislotasi, triftoridbor 

va faollashtirilgan ftor bilan alkillashda ishlatiladi. Aniqlanishicha, amfoter 

oksidlarning faolligi yuqori ekan (Al2O3, Cr2O3 va boshq.). 

4. Seolitlar,  umumiy formulasi M2/nО
.Al2O3

.xSiO2
.yH2O, bunda М – metall; 

n – uning valentligi.  

5. Kationitlar, –SO3H, -COOH, -PO3H2 va boshqa guruhlarni tutgan 

polimerlar. 

Alkilgalogenidlar va alkenlar bilan alkillash jarayonida katalizator kam 

miqdorda olinadi, spirtlar bilan alkillashda esa katalizator kam miqdorda olinsa, 

Lyuis kislotalari katalizatorlarning faolligini kamaytirib yuboradi. 

Arenlarni alkilgalogenidlar va inert erituvchilar (nitrobenzol) ishtirokidagi 

alkillash reaksiyasi keng foydalaniladi: 

ArH  +  RX                        Ar-R  +  HX
 

Alkilgalogenidlarning faolligi birlamchi alkildan uchlamchi alkil tomon ortadi. 

Reaksiyaning tezligi asosan Lyuis kislotalarning tabiatiga bogʻliq. 

Lyuis kislotalarining tabiati, birinchidan, arenga hujum qilayotgan elektrofil 

zarrachaning tuzilishi va qutbliligiga bogʻliq: 

RCl  +  AlCl3                  R    Cl    AlCl3                    R
+ || AlCl4

-                 R+  +  AlCl4
-







 

Bu zarrachaning ishtirokida qutblangan kompleks hosil boʻladi.  

Ikkinchidan, Lyuis kislotalari reaksiyaning tezligi, mahsulotning tarkibini 

hamda substratning izomerlanish qobiliyatini belgilab beradi [19]. 

1.4. Ferrotsen va uning xossalari 

Ferrotsen hosilalari strukturasi boʻyicha gem yadrosini eslatadi. Shuning  

uchun qon – tomir organlari funksiyasiga ijobiy ta’sir etadigan preparatlar ishlab 

chiqish asosiy aktual muammolardan biri hisoblanadi. 
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 Qishloq xoʻjaligida sintetik biostimulyator ta’sirida paxta va bir qator 

boshqa oʻsimliklar yetishtirishni tezlashtirish muhim iqtisodiy-xoʻjalik 

ahamiyatiga  ega. Garchi paxtachilikda paxta chigitining oʻsishini tezlashtirishning 

bir qancha usullari ma’lum boʻlsa–da, yuqori effektiv biostimulyatorlar ishlab 

chiqarish sintetik kimyoning aktual muammolaridan hisoblanadi. 

 Turli xildagi kleyli kompozitsiyalar ma’lum. Ularning bir qatori tirik 

toʻqimalarni kleylash uchun tavsiya etilgan. Tirik toʻqimalarni kleylashda bio–

kleyning gemostatik xossalari va 2 – 3 minutda kleylash muddati muhim ahamiyat  

kasb etadi. Ayniqsa, barcha ma’lum kley kompozitsiyalari  tinchlantiruvchi 

xossalarga ega emas. Bu bilan bogʻliq ravishda tibbiyot uchun yuqori gemostatik 

xossaga va oz muddatda tirik toʻqimalarni kleylashga, shuningdek, tinchlantiruvchi 

xossaga ega boʻlgan bio–kley kompozitsiyalari ishlab chiqish zamonaviy fanning 

asosiy aktual muammolarridan biri [20]. Ferrotsen kashf etilgandan soʻng koʻp 

sonli ishlarda ferrotsen siklopentadiyenil halqasining aromatik tabiati isbotlandi va 

uning bir qancha hosilalarining qator bebaho hosilalari koʻrsatilgan. Ferrotsen 

aromatik hosilalarining turli sintez usullari ishlab chiqilgan. 

1954 - yilda A.N. Nesmeyanov va E.G. Perevalova hamkasblari bilan 

ferrotsenning n – nitrofenildiazot bilan efir – suvli muhitdagi ta’sirini oʻrganib, 

reaksiyada azotning ajralib chiqishi va p-nitrofenilferrtsen hosil boʻlishi bilan 

borishini aniqlashtirib, olingan birikmalarining tuzilishi p – nitrobenzoy kislota 

bilan  kaliy permanganatning ishqoriy eritmasida oksidlash yoʻli bilan isbotlangan. 

 A.N. Nesmyanov hamkasblari bilan ferrotsen  hosilalarini oʻrganish borasida 

izlanishlarini davom ettirib, ferrotsenning  azobirikmalar bilan ta’sirini oʻrganishdi. 

Mualliflar shuni aniqlashdiki, arilferrotsenning hosil boʻlishi erkin radikal 

mexanizmi boʻyicha boradi. Ferrotsenning p – olildiazoxlorid, shuningdek,  p – 

anizildiazoxlorid bilan reaksiyasi oʻrganildi. Diazotrlash natijasida p – 

anizilferrotsen va ferrotsenning bir qator boshqa hosilalari olindi. Anilin va 

ferrotsendan  diazotrlash metodi bilan 42 % unumda fenilferrotsen olindi. Sintez 

qilingan birikmalarining tuzilishi spektral metod bilan oʻrganildi. 
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  Natijada ishlarida ferrotsenning aminofenol bilan dietil efirli muhitda 

reaksiyasi oʻrganilgan; p – ferrotsenilfenol 39 % unum bilan olingan. Ayniqsa, 

nitrofenilferrotsen 86 % unum bilan olingan. 

 Ferrotsenilamin ferrotsenillitiy va gidroksilaminning benzil efiridan olingan. 

Shuningdek, ferrotsenilaminning nordon tuzi va N– asetilferrotsenilamin olingan. 

Mualliflar tomonidan p – ferrotsenilamin aromatik amin xossaga egaligi 

isbotlangan, lekin, uni ferrotsenil guruh bilan nitrat kislota ta’siri natijasida 

diazotrlash mumkin emas.  

 Brodxeg G. va Poson P. diazotlash metodi bilan mono va difenilferrotsen, o 

– tolilferrotsen, m – xlorfenil va  dimetoxlorfenilferrotsenni sintez qilishgan. p - 

Gidroksifenilferrotsen 14 %, o–karboksifenilferrotsen 75%, o– va p– 

nitrofenilferrotsen 5 va 18 % unum bilan olingan. p–Anizildazanni ferrotsenga 

ta’siridan gomoannulyar dianizilferrotsen olingan. Ferrotsen Kili va Poson 1951 

yilda siklopentadiyenning oʻziga xos birikmasi – disiklopentadiyeniltemir hosil 

qildilar. Uni siklopentadiyenning magniyorganik birikmasi va temir (II) xloriddan 

olish mumkin. 

2C5H5MgBr + FeCl2 → (C5H5)Fe + MgBr2 + MgCl2 

Gaz holatidagi siklopentadiyennni qaytarilgan temir ustidan 3000 C da 

oʻtkazish ferrotsen olishning ancha oddiy usulidir: 

2C5H5   → (C5H5)Fe + N2 

N-akseptroferrotsen va N-ferrotsen aminosirka angidridi bilan H3PO4 

ishtirokida aniqlanadi, bunda ham oʻrin almashinmagan besh halqada sodir boʻladi. 

Ferrotsil, p-toluol va xlorferrotsenni aminometillash ham asosan erkin halqada 

boradi. Getero- va gomoannulyar izomerlar nisbati taxminan 5:1 fenilferrotsen 

holatida ikkita gomoannulyar izomerlar ajratib olingan . 

Fe

H

(CH3)2NCH2N(CH3)2

H3PO4

Fe

H

CH2N(CH3)2

Fe

CH2N(CH3)2

R
+

R=C6H5, p-CH3C6H4 , Cl  
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 Getero- va gomoannulyar izomerlar xromotografik usulda Al2O3 

formaldegid qizdirilgan holda ajratib olingan. 

Gomolitik reaksiyalar. Aromatik diazobirikmalar bilan ta’sirlashib, ferrotsen 

yuqori unum bilan mono- va diarilferrotsenlar hosil qiladi. Diazobirikmalarni p-

tolil, metil, etil, atsetil, karbometoksiferrotsenga ta’sirida arillanish mahsulotlari 

aralashmasi hosil boʻladi. 1,1- diatsetil ferrotsenlar diazobirikmalar bilan ferrotsen 

yadrosi parchalanishi bilan ta’sirlashadi.  

Ferrotsenning tuzlari (yoki FeCl3 ishtirokida ferrotsen) TGF da sianid kislota 

bilan sianlanadi. Bunda ferrotsen karbon kislota nitrili hosil boʻladi. (unum 80-

86%). 

(C5H5)2Fe
+HCN

C5H5FeC5H4CN  

Shu yoʻllar orqali ferrotsen boshqa birikmalar bilan reaksiyaga kirishadi.  

 Fenilferrotsenni temir va sianid kislota ishtirokida sianlashda 

fenilferrotsenkarbon kislota nitrillari izomerlar aralashmasi hosil boʻladi. Nitrillar 

aralashmasi H2O ishtirokida ishqor bilan gidrolizlanib tegishli amidlar olinadi. 

Ulardan esa Al2O3 da xromotografiya usulida 1,2 1,3 va 1,4 fenilferrotsen 

karbonkislota amidlari olinadi. 

 

CN

CONH2

Fe

 -C6H5 FeCl3,HCN

TGF
Fe

 -C6H5

CN

Fe

 -C6H5

Fe

 -C6H5

NC

Fe

 -C6H5

CONH2

Fe

 -C6H5

Fe

 -C6H5

H2NOC

 

127-1280 C da suyuqlanadigan amid getoroannulyar tuzilishiga ega: uning IQ- 

spektrida 1000-1100 sm-1 sohasida yutilish chiziqlari yoʻq. 1,2 va 1,3 izomerlar 

tuzilishini ularning Al2O3 dan adsorbsion xossalaridan aniqlash mumkin. 

 p-Ferrotsenilbenzoy kislota amidi p-ferrotsenilbenzoy kislotaga xlorli tionil 

va ammiak ta’sir ettirib olinadi: 
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C6H4FeC6H5 COOH
C6H4FeC6H5 CONH2

 

p-Ferrotsenilbenzoy kislota amidi xossalari (UB spektrda oksidlanish-

qaytarilish potensiali) fenilferrotsen karbonkislota amidlari xossalaridan katta farq 

qiladi [21]. 

1.4.1. Ferrotsen hosilalarida elektrofil oʻrin olish reaksiyasi 

Ferrotsen gruppasiga bogʻlangan alkil gruppasi keyingi elektrofil oʻrin 

olishlarini yengillashtiradi, bunda uning oʻzi bogʻlangan siklopentadiyenil halqasi 

kuchliroq aktivlik namoyon qiladi. Avval koʻrsatilganidek, p-ferrotsenilanilinning 

asoslilik konstantasini va p-ferrotsenilfenolning ionlanish konstantalarini benzol 

hosilalarining xos konstantalarini solishtirish natijasida aniqlanadi. Malumki, 

ferrotsenil gruppasiga nisbatan fenil gruppasi elektronoakseptor hisoblanadi. 

Rozenblyumning fenilferratsenning atsillanishi haqida ma’lumotlari 

natijalarni tasdiqlaydi: boshqa elektronoakseptor oʻrin oluvchilarga oʻxshab, fenil 

gruppa ferratsin qatori vodorodlarinnig elektofil oʻrin olishiga susaytiruvchan ta’sir 

oʻtkazadi. 

Fenilferrotsening aminometillanishi, sulfatlanishi va nitratlanishini hamda 

ferrotsen bilan raqobatlasha oladigan fenilferrotsen atsetillanishini oʻrganilgan. 

Aminometillashni fosfat kislota ishtirokida tetrametildiaminmetan bilan 

oʻtkaziladi. Bunda fenilferrotsen olingan. Mahsulotning IQ spektri 1000 va 1100 

sm-1 sohada yutilish chiziqlari bor, biroq chiziqlar intensivligi yuqori emas. 

Koʻrinib turibdiki, gomomolekulyar izomer koʻp hosil boʻlmaydi. Fenilferrotsen 

yodmetilatga aylanadi va natriy amalgamasi yordamida metilfenilferrotsengacha 

qaytariladi. Reaksiya mahsulotlarida geteromolekulyar metilfenilferrotsen ajratib 

olingan. 
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Fe

C6H5
(CH3)2NCH2N(CH3)2

H3PO4

Fe

C6H5

CH2N(CH3)2

CH3J

Fe

C6H5

CH2N(CH3)3J

Na/Hg
Fe

C6H5

CH3  

Bu boshlangʻich fenilferrotsen aralashmasining asosiy qismini 

geteromolekulyar izomer tashkil qilishini koʻrsatib turibdi, natijada 

fenilferrotsenning aminometillanishi erkin siklopentadiyen halqasiga boradi. 

Fenilferrotsenni dioksansulfoftorioksid bilan sulfirlanishida ferrotsen 

sulfokislota hosil boʻlish holatida 1-1 –fenilferrotsensulfokislota olinadi. 

C6H5C5H4FeC5H5

SO3, dioksan
C6H5C5H5FeC5H4SO3H2

 

Fridel-Krafts reaksiyasida fenil gruppasining ferrotsenil halqasiga 

susaytiruvchi ta’siri yaqqol koʻrinadi. AlCl3 ishtirokida fenilferrotsen va ferrotsen 

aralashmasining atsetil xlorit bilan atsillashda 25% unum bilan atsetilferrotsen, 5% 

unum bilan atsetilfenilferrotsen olinib, bunda 64% Fenilferrotsen va 30% ferrotsen 

oʻzgarishsiz qaytadi. Demak, fenilferrotsenga nisbatan ferrotsen osonroq 

atsetillanadi. 

Fenilferrotsenni nitrollashni S-C muhitda AlCl3 ishtirokida oʻtkazib, p-

nitrofenilferrotsenni 15% unum bilan olamiz. 

3

Fe
C2H5ONO2

(AlCl3)
Fe

NO2

 

p-Nitroferrotsen va reaksiyaga kirishmagan fenilferrotsenning bir qismi 

oksidlanmagan holda chiqadi. Koʻrinib turibdiki, bu reaksiya fenilferrotsenning 

oʻzi bilan boradi, uning kationi bilan emas. Bunda ferrotsenil halqasining saqlanib 

qolinishi e’tiborimizni tortadi. Ferrotsenni oʻzini bu sharoitda nitrolashni iloji yoʻq. 
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Ferrotsenni turli reaksiyalar bilan nitrolash nitroniyning boroftoridi bilan ham 

ishonchli natija beradi. Har qaysi holatlarda ham ferrotsenni kationga oksidlanishi 

kuzatiladi. 

Ferrotsen arildiazoniylar bilan ta’sirlashib, Brodhed va Poson tomonidan 

ta’kidlangani kabi arilferrotsenlarni hosil qiladi. Ferrotsenning ferrotseniy kation 

sifatida arillanishi U. Eynmayr tomonidan amalga oshirilgan. Bunda asosiy 

mahsulotlar mono- va diarilferrotsenlardir. Diarilferrotsenlardagi aril gruppalari 

har xil siklopentadiyenil halqalarida joylashgan. Faqatgina ferrotsen p-

anizildiazonni ta’sir ettirib, ozroq unum bilan gomoannulyar dianizilferrotsen olish 

mumkin. p-Tolilferrotsen p-tolildiazoniy bilan aralashib geteroannulyar di(p-tolil) 

ferrotsen 9% unum bilan olish mumkin. 

C5H5FeC5H4C6H4CH3
p

p
p

CH3C6H4N2Cl
Fe(C5H4C6H4CH3 )2

 

Reaksiya muhitini oʻzgartirish unumni u qadar ham oʻzgartirgani yoʻq. 

Nosimmetrik diaril sintezida kuzatilgan p-tolildiazonining kam faolligi 

reaksiyaning unumini past ekanligini isbotlaydi. Parchalanish vaqtida di-(p-tolil) 

ferrotseniy kationi p-tolilferrotseniyga nisbatan 1,5 marta chidamsizroq ekanligi 

koʻrinadi. Kation koʻrinishidagi mahsulotni kislotali eritmada parchalash mumkin. 

Bu taxmin toʻgʻriligi p-tolilferrotseniy kationini arillashda di-(p-tolil) ferrotsen 

olinmaganligi koʻrsatadi. 

Metilferrotsenga fenildiozoniy ta’siri natijasida past unum bilan 

geteroannulyar metilfenilferrotsen ajratib olinadigan metilferrotsenning fenillangan 

aralashmasi olinadi. 

CH3C5H4FeC5H4C6H5C5H5FeC5H4CH3

C6H5N2X

 

Metilferrotsenning bir qismi 21% unum bilan oʻzgarishsiz qaytadi. 

Etilferrotsenning fenildiozoniy arillanishida 20% unum bilan ozroq gomoannulyar 

izomerga ega geteroannulyar etilfenilferrotsenli monofenillashgan etilferrotsen 

ajratib olinadigan etilferrotsenning fenillanish mahsulotlari aralashmasi olinadi. Bu 

hodisa spektroskopik aniqlangan. 
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Metilferrotsen va fenilferrotsenning aminometillanishini kuzatib, bunda metil 

gruppasi reaksiyani osonlashtirib oʻzi bogʻlangan siklopentadiyenil halqasi 

faolligini oshirishini aniqlangan. Fenil gruppasi reaksiyani qiyinlashtiradi va oʻrin 

olish erkin halqada boradi. Fenilferrotsenning spektrda mahsulotlardagi 

gomoannulyar izomer borligi kuzatilgan. 

(N,N-dimetilaminometil) Fenilferrotsenning gomo- va geteroannulyar izomeri 

formamid bilan toʻyintirlgan alyuminiy oksidiga xromotografik boʻlinishi 

oʻrganilgan. Geteroannulyar va ikkita gomoannulyar (N,N-dimetilaminometil) 

fenilferrotsenni ajratib olingan. 

Xromotografiyadan soʻng olingan aminlarning 82% ni geteroannulyar izomer, 

15% va 3% gomoannulyar izomer tashkil qildi. Gomoannulyar izomerlardagi 

oʻrindoshlar holatlari aniqlanmagan. Bundan tashqari uchta aminning barchasi 

oʻzining yodmetilatlariga aylanib ular uchun parchalanish temperaturalari 

aniqlangan. 

Fe

R
(CH3)2NCH2(CH3)2

Fe

R

CH2N(CH3)

Fe

R

CH2N(CH3)2

H3PO4

(R=C6H5, p-CH3C6H4,Cl  

p-Tolil va xlorferrotsenning aminometillanishi huddi fenilferrotsenning 

aminometillanishidagi sharoitda H3PO4 ishtirokida N,N,N,N-

tetrametildiaminometanda oʻtkazildi. Ikkala holatda oʻrin olish jarayoni erkin 

pentadiyenil halqasida boradi. Reaksiya mahsulotlari formamid bilan toʻyintirilgan 

alyuminiy oksidiga boʻlinadi. Olingan aminlar Rf yordamida turli erituvchilarda 

ifodalanadi, bundan tahqari ular yodmetilatlarga aylangan 1,1 (N,N-

dimetilaminometil) p-tolilferrotsen yodmetilatidan natriy amalgamasi tasir ettirib 

1,1-metil-p-tolilferrotsen olingan 
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CH3

Fe

CH2N(CH3)3J

Na/Hg
CH3

Fe

CH3
 

Xlorferrotsenning aminometillashgan yodmetilatiga natriy amalgamasini tasir 

ettirib Cl2 saqlamaydigan modda olinadi. Getero- va gomoannulyar (N,N-

dimetilaminometil) p-tolilferrotsenning nisbati 5:1. Xromotografiyadan soʻng 

olingan aminlarning 80% geteroannulyar (N,N-dimetilaminometil) xlorferrotsen, 

11% esa gomoannulyar xlorferrotsenni tashkil qiladi. Bundan tashqari moddaning 

bir qismi (9%) sof holatda chiqmagan, ammo IQ spektrda tekshiruvda uning 

gomoannulyar izomer ekanligi aniqlangan. Koʻrinib turibdiki, getero- va 

gomoannulyar (N,N-dimetilaminometil) xlorferrotsen nisbatlari ham 5:1 ga teng. 

Shunday qilib p-tolil va xlorferrotsenning aminometillanishi huddi 

fenilferrotsendagi kabi erkin siklopentadiyenil halqalarida boradi [22]. 

α-Ferrotsenilkarbon kislota tuzlari. Konsentrlangan HCl ning 

difenilferrotsenilkarboniyning sirka kislotadagi eritmasi ta’sirida ferrotsen 

sistemasi buzilib, 6-6 difenilfulven hosil boʻladi. 

Reaksiyadagi oraliq mahsulot-(ferrixlorid) difenilferrotsenilkarboniyni ajratib 

olingan. HCl bilan birga HClO4 olinsa, unda difenilferrotsenilkarboniyning 

perxlorati hosil boʻladi. Bu tuzlar toʻq koʻk rangli kristall moddalar, efir va 

benzolda erimaydi, atseton va nitrolaktamda yaxshi eriydi. Tuzining atsetonli 

eritmasiga suv qoʻshilganda difenilferrotsenilkarbinol hosil boʻlishi kuzatiladi. 

C(C6H5)2

Fe OH

C(C6H5)2

Fe X-

(X=FeCl4, ClO4) 

Konsentrlangan HCl qoʻshilganda esa, ferrotsen molekulasining toʻliq 

parchalanishi kuzatiladi (6-6-difenilfulven ajratib olinadi). 

1959-yilda ferrotsen va ferrotsenilaldegid yoki HCOOH kondensatsiyasidan 

hosil boʻlgan diferrotsenilkarboniyning perxlorati oʻrganilgan. Suyuq SO2 da 

difenilkarboniyning geksaxlorantimonati va geksaftorantimonati olindi. Suyuq SO2 
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da alkilftorid va SbF5 dan olingan dimetil, trimetilkarboniyning 

geksaftorantimonatlari yaxshi oʻrganilgan. 

α-Ferrotsenilmetil kationi oson hosil boʻlishi huddi trifenilmetildagi tartibda 

ekanligi ehtimoli bor, negaki ferrotsenilkarbinil va metilferrotsenkarbinilatsetat 

solvoliz tezligi trietilatsetat tezligi bilan teng. 

α-Ferrotsenilkarbon ionining mustahkamligi temirning 3d orbitallari va 

karboni ionining vokant orbitallari qoplanishi bilan ifodalanadi. 

Olimlar tomonidan ferrotsenilfenilkarboniyning mustahkamroq tuzlari 

olingan.  

CHC6H5

Fe X-

(X=ClO4, B(C6H5)4) 

Ferrotsenilfenilkarboniyning tetrafenilborati piridinda tetrafenilborat N-

(ferrotsenilfenilmetil) piridinni beradi.  

CHC6H5

Fe
C5H5N

Fe

CH

C6H5

N

 B(C6H5)4  B(C6H5)4

 

500C nitrometanda ferrotsenilfenilkarboniyning tetrafenilborati termik 

parchalanishi 1, 2-difenil-1,2-diferrotseniletan aralashmasi hosil boʻladi.  

α-Ferrotsenilkarbon kislotalarning oson ikkilanishi ushbu sxemada 

koʻrsatiladi.  

Fe

CHC6H5

Fe

CHC6H5

Fe

CHC6H5

Fe

CHC6H5

Fe

CHC6H5

Fe

CHC6H5

 Lekin ma’lum boʻldiki, ferrotsenilfenilkarbonat va difenilferrotsenilkarbonat 
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perxloratlari diamagnit va karboniy ion strukturasi bilan bogʻliq. 

Ferrotsenilfenilmetil kationining radikaligacha qaytarilishi kuzatilishi ehtimoli bor. 

Fe

CHC6H5

 

Faqatgina tetrafenilborat anion qizdirilishida boradi. Nitrometanda 

ferrotsenilfenilkarboniy boroftoridi qizdirilishi natijasida 1,2-difenil-1,2-

diferrotseniletan oson hosil boʻlishi kuzatilmaydi. 

1962 yilda ferrotsenning ayrim hosilalarini yorugʻlik nuri ta’siri ostida 

parchalanishi kuzatilgan. Bu xossa koʻplab birikmalarda oʻrganilgan. 

Trialkilferrotsenilamin tuzlari fotolizi natijasida 

trialkilammoniysiklopentadiyenilidlar hosil boʻladi. Bunday ilidlar kam 

oʻrganilgan. “Ilid’’-kristall modda, suyuqlanish temperaturasi 118-1200C, kislotali 

eritmalarda kation siklopentadiyenil anioniga birikadi. Ilidning sirka kislotali 

eritmasiga tetrafenilbornatriyning suvli eritmasi qoʻshilishi natijasida 

metildietilsklopentadiyenil ammoniyning tetrafenilborati choʻkadi. 

Oʻrin olish reaksiyalarida siklopentadiyenil anionining aromatik xossalari 

namoyon boʻladi. N-bromsuksinimid metildietilammoniysiklopentadiyenilidiga 

ta’siri natijasida metildietilsiklopentadiyenilid olinadi. 

Azot birikish reaksiyalari oson boradi 

Metildietilammoniysiklopentadiyenilidning suvli eritmasiga 00C da fenildiazon 

boroftoridning metanolli eritmasini qoʻshish natijasida ilid hossasiga ega (kislotada 

eriydi, ishqorda yana choʻkadi) azohosilali toʻq-olcha tusli choʻkma aralashmasi 

hosil boʻladi. 

Fe

N

CH3

C2H5

C2H5 N

CH3

C2H5

C2H5  

N-ferrotsenilizoindolin yodometilati fotolizida N-metilizoindoliniy 

siklopentadiyenilid hosil boʻladi (suyuqlanish temperaturasi 145-1460C).  
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Fe

N

CH3

C2H5

C2H5 N

CH3

C2H5

C2H5

Br2

BrBr

Br

Br  

Bu modda metildietilammoniysiklopentadiyenilidga nisbatan suvda qiyinroq 

eriydi va fotoliz vaqtidayoq eritmadan rangsiz kristallar sifatida choʻkadi. Barcha 

pentadiyenilidlar kabi kuchsiz kislotalarda eriydi va ishqor qoʻshilishida yana 

choʻkadi. “Ilid”larning sirka kislotali eritmalari tetrafenilbornatriy bilan rangsiz 

tetrafenilborat hosil boʻladi: 

Fe

N
CH2

CH2
CH3 N

CH2

CH2
CH3

hv

 

n-Metilizondoliniysiklopentadiyenilid olishda boshlangʻich modda n- 

ferrotsenilftolimid u n-ferrotsenilizoindolinda litiy alyuminiy gidridi yordamida 

qaytariladi. 

Ferrotsenning siklopentadiyenil halqalaridan uzoqlashmagan musbat zaryadli 

oʻrindoshga ega ferrotsenning hosilalari ham yorugʻlik nuri ta’siriga chidamsiz. Bu 

ishda α-piridilferrotsen vinilog yodmetilati va trialkilferrotsenilammoniy kationi 

“fenilog” i oʻrganiladi. Yorugʻlik nuri ta’siri ostida ferrotsen sistemasi buziladi va 

N-metil-α-piridin-1-eten-2-siklopentadiyenilid hosil boʻladi. 

N
CH2

CH2
CH3

C5H5 B(C6H5)4

 

U kislotada eriydi, ishqorda esa qayta choʻkadi, sirka kislotali eritmalarda 

tetrafenilbornatriy bilan sariq rangli choʻkma beradi. 

p-Dimetilaminfenilferrotsenni yorugʻlik nuri ostida ham ferrotsen sistemasi 

buzilishi kuzatiladi. 
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Fe

CH CH
N

CH3
CH CH

N

CH3

CH CH
N

CH3 

Hosil boʻlgan ilid fotoliz vaqtidayoq protonlashadi. Fe(OH)3 dan filtrlangan 

suvli ishqorli eritmasiga tetrafenilbornatriy qoʻshilsa tetrafenil borat choʻkadi. 

Fe

N
CH3
CH3
CH3 hv

N
CH3
CH3
CH3

 

C5H5 N(CH2)3B(C6H5)4 

Uning tuzilishi haqidagi savol hozirgacha ochiq qolyapti.Ilid protonlanishi 

natijasida uchta kation hosil boʻladi [23] 
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II. BOB. FERROTSEN VA UNING ENG MUHIM HOSILALARINING 

AMALIY AHAMIYATI 

2.1. Ferrotsenning ayrim hosilalarining ishlatilishi 

Hozirgi kunda xalq xoʻjalini jadal rivojlantirish va aholining oʻsib 

borayotgan ehtiyojlarini yanada toʻlaroq qondirish  uchun qishloq xoʻjaligi 

mahsulotlaridan kundan-kunga yuqori hosil olish zaruriy holatlardan biri boʻlib 

qolmoqda.  Paxtachilikdan yuqori hosil olishning eng maqbul yoʻllaridan biri 

samarali biostimulyatordan foydalanish hisoblanadi.  Hozirgi kunda Markaziy 

Osiyo respublikalarning hech qaysinisida qishloq xoʻjaligida, ayniqsa, 

paxtachilikda aniq bir yuqori samara beruvchi stimulyatorlardan 

foydalanilayotgani yoʻq. Oʻzbekiston Respublikasi kimyolashtirish va 

oʻsimliklarni himoya qilish vositalari davlat komissiyasi tomonidan paxtachilikda 

quyidagi preparatlarni qoʻllashga ruxsat berilgan: “AGROZIM”, “P-4”, “MIVAL-

AGRO”, “VITAVAKS”, “VITAROS”, “KMU”, “MOVIY”, “NATRIY 

GUMMATI”, “NITROLIN”, “ROSLIN”, “TJ-85”, “UCHQUN”, “EKSTRASOL”, 

“HOSIL” VA “UNUM” [1]. Ammo yuqoridagi stimulyatorlar moddalardan 

koʻpchiligi ishlatilmaydi yoki kam ishlatiladi. Shuningdek, ular ichida eng 

samarali deb hisoblangan “MIVAL”, “BIZAR PLYUS”, “MIVAL-AGRO” kabi 

preparatlar respublikamizda ishlab chiqarilmaydi, balki ushbu preparatlar chet 

davlatlardan valyutaga olib kelinadi. Bu esa iqtisodiy jihatdan samarador emas.  

Mamlakatimiz olimlari oldida turgan eng muhim vazifalardan biri ekologik 

toza, yuqori samaradorlikka ega boʻlgan, paxta tolasining sifat koʻrsatkichlariga 

ijobiy ta’sir etib, paxta hosilining erta pishib yetilishi va hosildorligini sezilarli 

oshiruvchi hamda kam sarf-harajat talab etadigan yangi biostimulyatorlar avlodini 

yaratishdan iboratdir. Andijon davlat universitetining kimyogar olimlari ushbu 

muammoni hal etish uchun tarkibida ferrotsen moddasini tutuvchi ferrotsen 

hosilalarini sintez qilib, ular asosida yangi olingan moddalarning suvda eruvchi 

tuzlarini olishni oʻz oldiga maqsad qilib oldi. Ferrotsen hosilalaridan olingan 

“MAKSIT-1”, “MAKSIT-2”, “MAKSIT-3”, “MAKSIT-4”, “MAKSIT-5” kabi 

biostimulyatorlar biologik faolligi oʻrganilgan [24]. 
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Ferrotsenilfenolning hosilalarini ishlatilishi 

Ferrotsen hosilalari antianemik birikmalar sifatida adabiyotlarda keltirilgan. 

Bunday ferrotsen hosilalari ichida koʻpchilikgi, suvda kam erishi sababli, 

shuningdek, qoʻshimcha ta’sirlari boʻlgani uchun amaliyotda qoʻllanilmagan. 

Ferrotsen hosilalari ichida yagona preparat o-ferrotsen karboksibenzoilning Na li 

tuzi, ferrotseron nomi bilan nomlanib, yuqori effektiv antianemik preparat sifatida 

Sankt-Peterburg ITI va RFA EOBI ning gematologiya boʻlimida, keng 

qoʻllanilgan. Ferrotseron antianemik dorivor preparatlar ichida oldingi oʻrinlarda 

tursa ham, oʻzining achchiq ta’mi va metalli qoʻshimcha ta’mga egaligi va suvli 

eritmalarda parchalanib ketishi sababli in’eksiya koʻrinishda foydalanishga 

noqulay hisoblanadi. 

Shuningdek, ferrotseronning toksik ta’siri yuqori boʻlib, siydik yoʻllarini 

yalligʻlaydi. Shu kamchiliklarga qaramay ferrotseron qariyib 30 yildan buyon 

foydalanib kelinmoqda. Mashhur chet el antianemik preparatlari ferrumlek, 

ferropleks va boshqa preparatlarni ham kamchiliklari bor.  

Professor I.M.Petrov nomidagi onkologiya va sogʻliqni saqlash vazirligini 

tavsiyasiga binoan, rasmiy hat 21.10.1986 yil № K-83a\86 bilan tasdiqlangan va p– 

ferrotsenilfenolning Na li tuzi dorivor preparat sifatida foydalanishga ruxsat 

berilgan. Bundan tashqari ferrotsenning aromatik hosilalaridan biri p– 

ferrotsenilfenolning Na li tuzi shamollashga qarshi vosita sifatida qoʻllanilgan, 

laboratoriyada “FERASK” nomi bilan farmakologik xossalari chuqur oʻrganilgan.  

Ferrotsen va uning hosilalari turli sohalarda ishlatiladi. Koʻplab 

mamlakatlarda ferrotsen va uning hosilalari buyurtma asosida ishlab chiqariladi, 

masalan, AQSH da Research Organic Inorganic Chemical Corp. nomli firmada 

ferrotsenning gomologlari, mono- va diatsiferrotsen, ferrotsenkarbon kislota 

hosilalari ishlab chiqariladi.  

Ferrotsenning o- va p-holatda gidroksil (OH) va boshqa oʻrinbosarlar tutgan 

aril birikmalari polimerlarning destruksiyasini oldini olishda yaxshi ingibitor 

ekanligi aniqlangan. Masalan, o-oksibenzoilferrotsen qoʻshilgan polimerlar 
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samoviy kemalarni qoplashda ishlatiladi. Quyida keltirilgan 5-jadvalda ayrim 

stabilizatorlar keltirilgan: 

Polimer smolasi Ingibitor 
Eksperemental 

ahamiyati PE* 

Melaminalkid 

Melaminformaldegid 

Polivinilbutiral 

Silikonalkid 

Melaminalkid 

 

2-oksibenzoilferrotsen (1%) 

2-metoksibenzoilferrotsen (5%) 

2- oksibenzoilferrotsemn (5%) 

2-oksibenzoilferrotsemn (1%) 

Dibenzoilferrotsen (1%) 

5000 

375 

320 

200 

260 

 

Ma’lumki, boʻyoqlar orasida tarkibida sian guruhi tutuvchi boʻyoqlar 

alohida oʻrin egallaydi. Lekin bunday boʻyoqlar uzoq muddat xizmat koʻrsata 

olmaydi.  

Titov, Lisitsina va Shemotovalar yashil rangli indolenin boʻyogʻini sintez 

qilishgan [25]: 

Fe

HCCH

CH3

CH3

N

J CH3
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III. BOB. ZAMONAVIY KVANT KIMYOVIY KOMPYUTER 

DASTURLARI 

3.1. Zamonaviy kvant kimyoviy dasturlar tavsifi 

Oʻzbek olimlari tomonidan yaratilgan 1997-yilda “Tovarlarni kimyoviy 

tarkibi asosida sinflash va sertifikatlash” fani kimyo fanlari qatoriga-02.00.22. 

shifri bilan kiritilgan. Shu fan asosida nafaqat tovarlarni, balki amalyotda 

qoʻllaniluvchi boshqa mahsulotlarni ham sinflash va sertifikatlash mumkin  Oxirgi 

vaqtlarda axborot texnologiyalarining shiddatli rivojlanishi tufayli kimyo fanlarini 

oʻqitish texnologiyasiga turli xil kompyuter dasturlari kirib keldi. Kimyoning 

asosiy obyekti – molekula juda kichik boʻlgani uchun uni oddiy koʻz bilan koʻrib 

yoki qoʻl bilan ushlash imkoniyati yoʻq. Ammo uning kattalashgan modelini hosil 

qiluvchi turli kompyuter dasturlari yaratildi. Bu dasturlardan kimyo fanlarini 

oʻqitishda samarali foydalanish uchun ularning xususiyatlarini bilish zarur. 

Bugungi kunda keng qoʻllaniluvchi ayirim kimyoviy kompyuter dasturlarining 

ba’zi xususiyatlari 1-jadvalda keltirilgan.   

6-jadval 

Kimyoviy kompyuter dasturlarning ba’zi xususiyatlari 

№ Dastur nomi Animatsiyali 

yoki 

animatsiyasiz 

Tili Boshqarish erkin 

yoki 

chegaralangan 

Ovozli yoki 

ovozsiz 

1 Crocodile chemistry 605 Animatsiyali Ingliz  Erkin ovozli 

2 Химия ( 8-11 класс ) 

Виртуальная лаборатория 

Animatsiyali Rus 

oʻzbek 

Qisman erkin ovozli 

3 Davriy_jadval Animatsiyali Oʻzbek Erkin ovozsiz 

4 Chemsk12 Animatsiyali Ingliz Erkin ovozsiz 

5 Химический калькулятор Animatsiyasiz Rus Chegaralangan  ovozsiz 
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6 ChemDraw Ultra 11.0 Animatsiyali Ingliz Erkin ovozsiz 

7 CHEMIX 12 Animatsiyasiz Ingliz  Chegaralangan ovozsiz 

8 GaussView Animatsiyali Ingliz  Erkin  ovozsiz 

9 ChembalanceWiziard32 Animatsiyasiz Ingliz  Chegaralangan  ovozsiz 

10 Xumua42 Animatsiyasiz Rus ingliz Chegaralangan  ovozsiz 

Yuqoridagi jadvalda berilgan kimyoviy kompyuter dasturlarining 

xususiyatlarini inobatga olib, ularni quyidagicha sinflarga boʻlishni taklif qilamiz. 

1. Animatsiyali, ovozli, bajarilish imkoniyati erkin dasturlar: Crocodile 

chemistry 605, Химия (8-11 класс) Виртуальная лаборатория;  

2. Animatsiyali, bajarilish imkoniyatlari erkin, ovozsiz dasturlar: Davriy 

jadval, Chemsk12, ChemDraw Ultra 11.0, Gauss View;  

3. Animatsiyasiz, bajarish imkoniyati chegaralangan, ovozsiz dasturlar: 

Химический калькулятор, CHEMIX 12, ChembalanceWiziard32, Xumua42.   

Kimyo fanlarini oʻqitishda yuqorida taklif etilgan kimyoviy kompyuter 

dasturlarini sinflash va qoʻlanilish borasidagi takliflar inobatga olinsa, ta’lim 

jarayonining samaradorligi yanada ortadi deb hisoblaymiz [26]. 

Kimyoviy hisoblashga doir dasturlar: Excel hisoblash funksiyasi asosida 

masalalar tuzush va yechish. Kimyodan masala yechishning ta’limiy ahamyati 

shundan iboratki, oʻquvchilar masalalar yechish jarayonida modda va jarayonlar 

togʻrisidagi kimyoviy bilimlari mustahkamlanadi. Kimyoviy jarayonlarning 

borishi, undagi omillar (temperature, bosim, katalizator va h.k.) ning ahamyati 

toʻgʻrisidagi fikrlari ortadi.  Aynan, kimyodan masala va mashqlarni yechishda 

hisob kitob ishlarini amalga oshirish uchun turli kimyoviy kompyuter dastulari 

boʻlib, ularga Chemsk 12, ChemDraw Ultra 11.0 GaussView, Chembalance 

Wiziard 32 va boshqa koʻplab dasturlar kiradi.  

Dasturlar bilan ishlashdan, ularni dars jarayoniga tadbiq etishdan avval 

dasturni shaxsiy kompyuterga sozlash dasturni tuzilishi bilan tanishib chiqish 

zarur. Koʻp hollarda dasturlarning oʻrnatilishi va uning tuzilishi xaqidagi 

yoʻriqnomalar ingliz rus va boshqa tillarda boʻlishi foydalanuvchiga biroz 
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qiyinchiliklarni paydo qiladi shu boisdan dasturlar tuzulishi va ular bilan ishlashda 

oʻzbek tilidagi yoʻriqnomalarni ishlab chiqishda kafedramizda bir nechta talaba va 

oʻqtuvchilar izlanish olib bormoqda. Izlanishlardan namuma sifatida bir nechta 

shunday dasturlarni shaxsiy kompyuterga sozlash va dasturni qisqacha tuzulishi 

bilan tanishib chiqamiz. Chemsk12. dasturini oʻrnatish uchun  NEXT tugmasi 

bosiladi.(1-rasm) 

  
 

1-rasm 

Hosil boʻlgan oynadan “Next>” tugmasi belgilanadi. Dastur toʻgʻrisidagi 

litsenziya ma’lumotlar bilan tanishdim deb belgilanadi. (2-rasm) 

   

2-rasm 

Hosil boʻlgan oynalar ketma-ketligidan “Next>” tugmasi bosiladi. (3-rasm) 

  

3-rasm 

1- Hosil boʻlgan oynadan “Next>” tugmasi, 2- Hosil boʻlgan oynadan “Install” 

tugmasini bosamiz. 
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 Dastur oʻrnatilish oʻynasi hosil boʻladi, soʻng dasturni oʻrnatishning oxirgi 

bosqichi yani “Finish” tugmasi bosiladi va dastur oʻrnatilish yakunlanadi va ishchi 

stolda dasturlar oynasi hosil boʻladi [27]. 

WinMopac dasturini kompyuter xotirasiga oʻrnatish WinMopac dasturini 

kompyuter xotirasiga muvaffaqiyatli oʻrnatish uchun quyidagi amallar ketma –

ketligi bajariladi: 1-amal. WinMopac dasturini oʻrnatadigan fayl ishga tushiriladi 

(4-rasm). 

 

2-amal. WinMopac dasturini oʻrnatadigan fayl tanlangandan keyin, ekranda 

dasturni qaysi tilda oʻrnatishni tanlash uchun “tilni tanlash” oynasi hosil boʻladi. 

Bu oynadan bajaruvchi uchun qulay boʻlgan til belgilanadi, masalan, rus tili. 

Soʻngra oynaning pastki qismidan “далее” buyrug`i tanlanadi (5-rasm). 

 

5-rasm. 

Keyingi amallar natijasida ketma-ket hosil boʻlgan oynalarning pastki 

qismidan “Далее” buyrug`i tanlanib borilishi kerak. Bu buyruq tanlanganda oyna 

avtomatik tarzda yopilib, yangi oyna hosil boʻladi va oxirgi oynadan “Ok” 

buyrug`ini tanlash bilan yakunlanadi (6-10-rasmlar). 
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6-rasm 

       

                       8-rasm.                                                     9-rasm. 

 

10-rasm. 

Yuqoridagi amallar toʻgʻri bajarilgandan soʻng, kompyuterda WinMopac 

dasturi ishlashga tayyor boʻladi [28]. 

ChemDraw Ultra 11.0 Dasturini oʻrnatish. ChemDraw Ultra 11.0 dasturini 

oʻrnatish uchun ChemOffice-2008 papkasi ichidagi install.exe fayli 

ishga tushiriladi Dasturni oʻrnatish oynasi hosil boʻladi va oyna ustidan dasturni 

aktivlashtirish uchun kod soʻraladi.  
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13-rasm 

Ularga mos ravishda ismingiz , tashkilot nomi , E-mail adresi va seriya 

nomeriga: 011-256104-7199 ni kiriting. Keyin «Activate Later» tugmasini bosing. 

Hosil boʻlgan oynada “ОК” tugmasini bosing . 14-rasmdagi oynadan  “Next” 

tugmasi bosiladi. 

  
 

14-rasm 

Keyingi oynadan Begin tugmasi bosiladi. Hosil boʻlgan oynada “Next” tugmasi 

bosiladi. Litsenziya qoidalariga amal qilish oynasida “YES” javobi olinadi va Next 

javobi olinadi va “Next” tugmasi bosiladi.  
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15-rasm 

Dastur oʻrnab boʻlgach “Finish” tugmasi bosiladi. Sistemani qayta yuklanish 

soʻraladi “YES” deb javob beriladi Sistema qayta yuklangach \ChemOffice-

2008\!Reg katalogida joylashgan “crack.reg” fayli ishga tushirilib u registrga 

qoʻshiladi. Shu katalogdagi RegCodeCOM11.dll fayli dastur oʻrnatilgan papkaga 

(bu papka asosanC:\ProgramFiles\CambridgeSoft\ChemOffice2008\Common\DLL 

manzilida joylashgan) koʻchirilib qoʻyiladi. U yerdagi fayl almashtiriladi [29].  

 

3.2. GAUSSIAN 98W dasturi 

Nemis olimi Tim Klark oʻzining monografiyasida kvant kimyoviy hisoblash 

metodlarini keltirgan va oʻrgangan. Gaussian dasturini birinchi marta J. Popl 

boshchiligida amerikalik olimlar tomonidan oʻrganilgan va Nobel mukofotiga 

loyiq deb topilgan. Oldingi dastur va metodlarning kamchiligi shundan iboratki, 

bitta molekulani hisoblash uchun sutkalab vaqt kerak boʻlgan hamda hatoga yoʻl 

qoʻysa, yana qaytadan hisoblashga koʻp vaqt sarflangan. Bundan tashqari hisob 

mashinalarining hajmi juda katta boʻlgan va ishlash tezligi ham past boʻlgan. 

Yuqori tezlikka ega boʻlgan kompyuterlarning ishlab chiqarilishi bilan kvant 

kimyoviy dasturlarning imkoniyati ham tubdan oʻzgardi. 

Kvant kimyoviy metodlarning afzalliklari: 

1) Tuzilishni tez hisoblab beradi; 

2) Eksperemental metodlarning aniqligi; 

3) Olingan natijalarning adabiyotlarda keltirilgan ma’lumotlar bilan mos 

kelishi, aniqligi; 

4) Hisoblashlarni oson va tez qayta ishga tushirish imkonining mavjudligi; 
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5) Erituvchi tanlash imkoni borligi; 

6) Molekulaning tinch va qoʻzgʻalgan holatini oʻrganish mumkinligi; 

7) Atomning zaryad taqsimotini mingdan bir ulush aniqlikda hisoblash 

mumkinligi; 

8) Sistemaning umumiy energiyasi va dipol momentini aniq hisoblash 

mumkinligi; 

9) Molekulaning tebranish spektrlarini hisoblash mumkinligi;  

10)  PMR va YaMR spektrlarini nazariy oʻrganish imkoniyatining mavjudligi; 

11)  Reaksiyaning mexanizmini modellashtirish mumkinligidadir. 

Nazariy metodlar kabi kvant kimyoviy metodlarda ham kamchiliklar mavjud: 

-ayrim yarimempirik metodlarda atomlar soning cheklanishi kuzatiladi; 

-molekuladagi atom soni ortishi bilan hisoblash vaqti ham ortadi; 

-kvant kimyoviy metodlar toʻgʻrisida oʻzbek tilidagi adabiyotlar mavjud emas. 

Shaxsiy kompyuterda GaussView 5.0.8 dasturini sozlash. Mazkur 

dasturni kompyuteringizga yuklab olishingiz uchun, shu dastur yuklangan 

kompyuter apparatidan, dastur jamlanmasini flesh kartangizga koʻchirib olasiz. 

Ushbu dastur jamlanmasi flesh kartangizga fayl koʻrinishida oʻtadi, fayl ichida esa 

PIN va SETUP boʻlimlari mavjud. SETUP boʻlimi ustida sichqonchaning chap 

tugmasi 2 marta bosilganda ekranda dasturning salomlashuv oynasi ochiladi.  

 
 

16-rasm 

Dasturni kompyuterga yuklanish ketma-ketkigini muvaffaqiyatli amalga oshirish 

uchun hosil. boʻlgan oynanaing pastki qismidagi NEXT buyrugʻi tanlanib borilishi 

kerak. Har bir buyruq bajarilgandan soʻng, oynalarning hosil boʻlish ketma-ketligi 
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davom etadi va Finish bilan yakunlanadi. Salomlashish oynasi avtomatik tarzda 

yopilib 2-oyna hosil boʻladi. 

 
 

17-rasm 

Toʻrtinchi grafikdagi oynaning Serial boʻlimiga dasturning Pin kodi 

kiritiladi, ushbu kod dastur fayli ichidagi Pin saxifasi ichida joylashadi. Shu kod 

raqamidan Serial bandiga nusxa koʻchiriladi va Next buyrugʻi tanlanadi. Oynada 

navbatdagi 5-grafik hosil boʻladi va bu oynadan OK buyrugʻi tanlanadi. Har bir 

hosil boʻlgan soʻrov hamda buyruq oynalarini Next va Ok buyruqlari orqali 

tasdiqlangandan soʻng dastur quyidagi koʻrinishda yuklana boshlaydi. 

 

18-rasm 

Yuklanish jarayoni yakunlangandan soʻng dasturni yuklanishi uchun Finish oynasi 

ochiladi va shu belgi tanlanadi. Yuqoridagi keltirilgan ketma-ketliklar toʻgʻri 

amalga oshirilgandan soʻng sizning kompyuterningiz GaussView 5.0.8 dasturi 

bilan ishlash imkoniyati paydo boʻladi [30]. 

GaussView5.0.8 dasturining interfeysi: Dasturda menyu boʻlimlarning 

koʻrinishi va ularga izohlar 



76 
 

7-jadval 

Quyidagi jadvalda GaussView dasturi menyularidagi tugmachalarining 

vazifalariga izohlar keltirilgan. 

Tugmacha 

N
o

m
i 

Menuga kirish yoʻli Izoh Qisqa 

klavshlar 

 

N
ew

 File=>New Yangi ishchi oynani hosil qilish.  

 

 

File=>New=> 

Create Mol. Group 

Ishchi oynada bir vaqtning oʻzida 

ikkita molecular guruh ustida ishlash. 

Ctrl-N 

 

O
p

en
 

File=>Open GaussView dasturida fayllarni 

yaratish.  

Ctrl-O 

 

 

File=>Recent Files Hosil qilingan yangi birikmalar uchun 

roʻyxat yaratish. 

 

 

 

File=>Related Files Ayni molekulaga aloqador boʻlgan 

fayllar (malumot fayli,roʻyxatdan 

oʻtgan fayl.)  

 

 

S
a
v
e 

File=>Save Molekula va molekulalar guruhini 

faylga saqlash.  

Ctrl-S 

 

P
ri

n
t 

File=>Print  View oynasidagi malimotlarni chop 

etish 

Ctrl-P 

 

S
a
v
e 

Im
a
g
e 

File=>Save 

Image File 

View oynasida yaratilgan grafik 

fayllarni koʻrsatish. 

 

 

P
re

fe
re

n
ce

s 

File=>Preferences GaussView dasturida yaratilgan 

birikmalarning xususiyatlari.  

 

 

 

File=>Exit GaussView dasturining barcha 

oynalarini yopish va undan chiqish. 

 

 

 

U
n

d
o

 

Edit=>Undo Ilgari taxlil qilinganlarni hozirgi 

holatdan teskarisiga qaytarish. 

Ctrl-Z 
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R
ed

o
 

Edit=>Redo Teskari holatdan avvalgi jarayonga 

qaytish. 

Ctrl-Y 

 

C
u

t Edit=>Cut Joriy tanlangan qismni ajratib olish. Ctrl-X 

 

C
o

p
y
 Edit=>Copy Joriy tanlangan qismdan nusxa olish. Ctrl-C 

 

P
a

st
e 

Edit=>Paste Joriy model nusxasini istalgan holatda 

saqlab qoʻyish. 

 

 

 

Edit=>Paste=>Add 

to Molecule Group 

Joriy molekula modelini yangi oynada 

hosilqilish. 

Ctrl-V 

 

 

Edit=>Paste=> 

Replace Molecule 

Joriy molekula bilan saqlangan 

molekulani oʻrnini almashtirish. 

 

  Edit=>Paste=>Add 

to Molecule Group 

Joriy molekula modelini yangi oynada 

hosilqilish. 

Ctrl-V 

  Edit=>Paste=> 

Replace Molecule 

Joriy molekula bilan saqlangan 

molekulani oʻrnini almashtirish. 

 

  Edit=>Paste=> 

Append Molecule 

Molekula oʻz ichiga olgan joriy 

boʻlakni ayni modeldan ajratib olish 

 

 

Delete Edit=>Delete Ayni molekulani butunlay oʻchirib 

yuborish. 

Ctrl-

Shift-V 

Del 

 

Atom 

List  

Editor 

Edit=>Atom List Molekulaning raqamli koordinatsion 

parametrlarini elektron jadval 

yordamida tahlil qilish.  

 

 

Redunda

nt  

Coord. 

Editor 

Edit=>Redundant 

Coordinates 

Gaussian ModRedundant orqali ichki 

keraksiz qism koordinatasini belgilash.  
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Connecti

on  

Editor 

Edit=> 

Connection 

Belgilangan molekula strukturasi bilan 

aloqador boʻlgan atomlar haqida 

ma’lumot (Opt=QST2 yokiQST3 

ma’lumot).  

 

 

Select 

Layer 

Edit=>SelectLayer Foydalanilgan atomlarning grafik qatlamlari uchun 

ONIOM hisoblashlar .  

  Edit=>Atom Groups Atom Group Editor, boʻlimi orqali foydali 

fragmentlar, ONIOM qatlamlar, belgilangan atomlar 

va boshqa guruhlarni ochish.  

  Edit=>PDB Residues PDB Residue Editorboʻlimi orqali 

belgilangan jarayondagi manbaaning 

dastlabki PDB fayllaridan birini 

ochish..  

 

  Edit=>PDB  

Secondary Structures 

PDB strukturasining ikkinchi muharriri berilgan 

manbaa ichidagi harakatlarni PDB fayl orqali 

ikkinchi strukturasini ochish (e.g.zanjir va helixes).  

  Edit=> 

Point Group 

Joriy modelning maxus simmetriyasini 

yuklash. 

 

 

Crystal 

Editor 

Edit=>PBC Elementning oʻzgartirilgan va yangi 

yaratilgan strukturasi. 

 

 

MO 

Editor 

Edit=>MOs Molekulyar orbitalning statsionar koʻrinishi. 

 

Symmet

rize 

Edit=>Symmetrize Simmetriyaning joriy guruhdagi 

tegishli modelini koʻrish. 

 

  Edit=>Reorient Molekulaning joylashgan oʻrnini 

aniqlashga yordam berish. 

 

 

Rebond Edit=>Rebond Bir xil atomlar chegarasi va ular 

oʻrtasidagi masofani hisoblash. 

 

 

Clean Edit=>Clean Moddaning molekulyar geometric 

shaklini kimyoviy qoidalarga muvofiq 

tarzdasozlash. 
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  Edit=>Mirror Invert Molekuladagi oʻzaro yaqin tanlangan 

atomlarning oʻrnini almashtirish. 

 

 

Add 

View 

View=>AddView Koʻrinib turgan oynada joriy 

molekulani mustaqil ravishda hosil 

qilish. 

 

 

Center View=>Center Molekulani koʻrilayotgan oynada 

markazga sozlash.  

 

  View=>Builder Builder bandiga oʻtish.  
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IV BOB. AMALIY QISM 

4.1. p-Ferrotsenilfenol va ferrotsenil benzoy kislotalarini Fridel-Krafts 

usulida alkillash reaksiyalarining kvant-kimyoviy tahlili 

Fan va texnika taraqqiyoti jadal rivojlanayotgan hozirgi davrda, 

Oʻzbekistonga barcha sohalar qatori kvant kimyosida ham katta yutuqlarga 

erishilmoqda. Zamonaviy kompyuter dasturlari asosida kimyoviy birikmalar 

tuzilishi va xossalarini oldindan aytib berish, reaksiya mexanizmlarini chuqurroq 

oʻrganish imkoniyati mavjud. 

Ayrim aromatik birikmalar alyuminiy xlorid ishtirokida galogenalkanlar, 

olefinlar va spirtlar bilan oson alkillanadi. Reaksiyaning tezligi galogen va 

alkillovchi reagent tabiatiga bogʻliq. 

 Fridel-Krafts usulida benzolni alkillash reaksiyasi natijasida mono-, di- va poli 

almashgan uglevodorodlar aralashmasi hosil boʻladi. Bu hodisa alkilbenzolni 

alkillash reaksiya tezligi benzolni alkillash reaksiya tezligidan yuqoriligi bilan 

ifodalanadi. Alyuminiy xlorid faqat aromatik halqadagi vodorod oʻrnini alkil guruh 

olishida ishtirok etmay, balki mahsulotlarni gidrogenlanishi, degidrogenlanishi, 

izomerlanishi va polimerlanish reaksiyalarida ham ishtirok etishi mumkin.  

 Benzolni alyuminiy xlorid ishtirokida alkillab izopropilbenzol olish reaksiyasini  

koʻrib chiqamiz. Suvsiz alyuminiy xloridda alyuminiy atomi tashqi pogʻonasida 

oltita elektroni bor. Bu atom propilxlorid elektronlari hisobiga oʻzini oktet holatiga 

toʻldiradi. 

CH3 CH2 CH2 Cl CH3 CH2 CH2 Cl AlCl3 CH3 CH2 CH2 AlCl4

Hosil boʻlgan karbokation stabilroq boʻlagan ionga izomerlanadi: 

CH3 CH CH3CH3 CH2 CH2  

AlCl4

CH3 CH CH3

AlCl4

CH3 CH CH3*
 

π-kompleks 
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H CH CH3

CH3

AlCl4

CH CH3

CH3

AlCl3 HCl

 

 

Ushbu reaksiyada barcha reagentlar quruq boʻlishi kerak, chunki alyuminiy xlorid 

namlikda ham gidrolizga uchrashi mumkin [31] . 

 p-Ferrotsenilfenol molekulasi benzoldan farqli ravishda elektronodonor guruh  

tutadi. Reaksiyani toʻlaroq izohlash uchun biz zamonaviy kvant-kimyoviy dastur 

Gaussian 98W dasturidan foydalandik. Reaksiyani modellashtirish uchun molekula 

va oraliq komplekslarni quyidagi tartibda belgilab oldik: 

Fe

1

OH

 

Fe

CH3H

OH

1 a  

Fe

CH3

OH

1 a*  

Fe

COOH

2
 

Fe
H

CH3

COOH

2a  

Fe

CH3

COOH

2a *  

Fe

H3C
COOH

3a*

 

Fe

COOH

3  

Fe

H3C
H COOH

3a  

Fe

COOH

4  

Fe

CH3 H

COOH

4 a

Fe

CH3

COOH

4 a*

σ-kompleks 
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Fe

CH3

H

COOH

4 b

 

Fe

CH3

COOH

4 b

 

Fe

H3C
H COOH

 

   

   

   

p-Ferrotsenilfenol va ferrotsenilbenzoy kislotalarini alkillash reaksiyasida 

dastlabki va oraliq reagentlar hamda reaksiya mahsulotlarining kvant-kimyoviy 

usullar bilan ularning geometrik kattaliklari, elektron tuzilishlarini o’rgandik.  

p-Ferrotsenilfenol va ferrotsenilbenzoy kislotalarini alkillash reaksiyasining 

mexanizmini nazariy o’rganish ancha qiyinchilik keltirib chiqaradi.  

Qiyinchiliklarni hal etishda biz zamonaviy kvant-kimyoviy metodlardan 

foydalandik. p-Ferrotsenilfenol va ferrotsenilbenzoy kislotalarini alkillash 

reaksiyalarini modellashtirishda Gaussian 98W dasturi DFT-B3LYP metodining 3-

21G bazisidan foydalandik. Bu dastur orqali biz reaksiya uchun zarur bo’lgan 

reagentlar: p-ferrotsenilfenol, o-, m-, p-ferrotsenilbenzoy kislotalari, metil xlorid; 

oraliq mahsulotlar; reaksiya mahsulotlarining zaryad taqsimoti, atomlar orasidagi 

bog’ uzunliklari, valent burchaklari, umumiy energiyalari, IQ, YaMR spektrlarini 

o’rgandik.  

OH

Fe
AlCl4

CH3

Fe

CH3H

OH

1 a

Fe

CH3

OH

1 a

Fe

H3C

H

OH

Fe

H3C

OH

1b
1b

1
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COOH

Fe
AlCl4

CH3

2 a

Fe
H

CH3

COOH

Fe

CH3

COOH

Fe

H3C

COOH

Fe

H3C

H
COOH

2 b 2 b

2

2 a

 

COOH

Fe
AlCl4

CH3

Fe

H3C
COOH

3a*

Fe

H3C
H COOH

3a

3
Fe

CH3

H

COOH

3 b

Fe

CH3

COOH

3 b
 

COOH

Fe
AlCl4

CH3

4a*

4

Fe

CH3

COOH

a

Fe

CH3

H

COOH

4 b

Fe

COOHH

COOH

4

Fe

CH3

COOH

4 b  

p-Ferrotsenilfenol va ferrotsenilbenzoy kislotalarini alkillash reaksiyalarida 

ishtirok etayotgan molekulalarning Gaussian 98W dasturining DFT metodi 

geptanli fazada to’la energiyalari hamda dipol momentlarini (8-jadval) hisobladik. 

Natijalar quyidagicha bo’ldi: 

8-jadval 
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Reagentlar va hosilalarning toʻla energiya qiymatlari E(kkal/mol), dipol  

momenti µ (D) 

Izoh: *-olingan mahsulotlar yulduzcha bilan ko’rsatilgan 

Yuqoridagi jadvalda keltirilgan oraliq  1a va 1b oraliq σ-komplekslarning 

energiyalar farqi ΔE= -627 kkal/molga teng. Bundan shunday xulosa kelib 

chiqadiki, 1a σ -kompleksning barqarorligi 1b holatdan, 2b σ -kompleksning 

barqarorligi 2a holatdan, 4b esa 4a holatdan, 3b* mahsulotning barqarorligi 3a* 

Molekulalaning 

nomeri 
DFT/B3LYP metodi 3-21G bazisi 

№ E, kkal/mol D, Debay 

1 -1221929 1,53 

1a 
-1221301 

2,36 

1a* 
-1220674 

1,0726 

1b 
-1220046 

4,30 

1b* 
-1219419 

1,57 

2 
-1218791 

1,3145 

2a 
-1218164 

5,4078 

2a* 
-1217536 

1,4633 

2b 
-1216909 

3,01 

2b* 
-1216281 

1,0915 

3 
-1215654 

1,98 

3a 
-1215026 

9,1211 

3a* 
-1214399 

2.3677 

3b* 
-1213771 

2,14 

4 
-1213144 

2,0984 

4a 
-1212516 

6,9650 

4a* 
-1211889 

2,4057 

4b 
-1211261 

6,7054 

4b* 
-1210634 

2,3495 
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dan  yuqoriligi aniqlandi. p-Ferrotsenilfenolga (1) alkil guruh biriktirilsa,  fenolga 

nisbatan o-holatga, (2) o-ferrotsenilbenzoy kislotaning alkillanishida m-holatga,  

m-ferrotsenilbenzoy kislotaning (3) alkillanishida getero-holatga, p-

ferrotsenilbenzoy kislotaning (4) alkillanishida esa getero-holatga (molekuladagi 7-

uglerodga) alkil guruhi energetik jihatdan oson birikadi.  

 

9-jadval. Malliken bo’yicha atomlardagi zaryad taqsimoti  

  

 

1b 1b* 2 

C1 -0.097 H7 0.268 H15 0.196 C1 -0.221 H7 0.206 H16 0.193 C1 -0.229 H9 0.215 

C2 -0.416 H9 0.309     C2 -0.370 H8 0.205     C2 -0.347 H10 0.209 

C3 -0.290 H10 0.255     C3 -0.354 H10 0.203     C3 -0.345 C11 -0.003 

C4 -0.297 C9* -0.408     C4 -0.360 C9* -0.626     C4 -0.364 C12 -0.114 

C5 -0.371 H91 0.244     C5 -0.329 H91 0.213     C5 -0.329 C13 -0.168 

C6 -0.274 H92 0.243     C6 -0.356 H92 0.212     C6 -0.362 C14 -0.189 

C7 -0.288 H93 0.250     C7 -0.350 H93 0.217     C7 -0.362 C15 -0.18 

C8 -0.430 C11 -0.024     C8 -0.351 C11 -0.014     C8 -0.366 C16 -0.202 

C9 -0.408 C12 -0.192     C9 -0.175 C12 0.199     C9 -0.363 C17 0.654 

C10 -0.432 C13 -0.202     C10 -0.365 C13 -0.212     C10 -0.374 O1 -0.485 

H2 0.242 C14 0.314     H2 0.203 C14 0.282     H2 0.208 O* -0.566 

H3 0.258 C15 0.169     H3 0.206 C15 -0.188     H3 0.214 H* 0.375 

H4 0.258 C16 0.207     H4 0.205 C16 -0.214     H4 0.212 H13 0.224 

H5 0.244 H12 0.209     H5 0.205 H12 0.19     H5 0.213 H14 0.20 

H6 0.277 H* 0.378     H6 0.218 H13 0.175     H6 0.217 H15 0.202 

O* 0.583 H13 0.21     O* 0.601 H* 0.354     H7 0.216 H16 0.213 

Fe  1.551 H15 0.234     Fe  1.585 H15 0.201     H8 0.216     

2a* 2a 2 b 

C1 
-

0.223 
H9 0.207 H62 0.214 C1 

-

0.173 
H10 0.248 H62 0.246 C1 

-

0.136 
H10 0.260 H32 0.239 

C2 
-

0.397 
H10 0.198 H63 0.225 C2 

-

0.369 
C11 

-

0.016 
H63 0.250 C2 

-

0.444 
C11 

-

0.014 
H33 0.250 

C3 
-

0.344 
C11 0.017     C3 

-

0.254 
C12 

-

0.105 
H6 0.350 C3 

-

0.362 
C12 

-

0.184 
H6 

-

0.259 

C4 
-

0.356 
C12 

-

0.118 
    C4 

-

0.394 
C13 

-

0.155 
    C4 

-

0.471 
C13 

-

0.163 
    

C5 
-

0.342 
C13 

-

0.155 
    C5 

-

0.241 
C14 

-

0.172 
    C5 

-

0.299 
C14 

-

0.171 
    

C6 
-

0.163 
C14 

-

0.187 
    C6 

-

0.352 
C15 

-

0.167 
    C6 

-

0.405 
C15 

-

0.150 
    

C7 
-

0.348 
C15 

-

0.176 
    C7 0.468 C16 

-

0.205 
    C7 

-

0.236 
C16 

-

0.114 
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4.2. p-Ferrotsenilfenolning IQ va PMR spektrlarining kvant kimyoviy 

tahlili 

p-ferrotsenilfenol (p-Fc-Ph-OH) molekulasining IQ va PMR spektrlari 

oʻrganilgan. Ferrotsen yadrosidagi vodorodlarni boshqa funksional guruhlarga 

almashinishi natijasida hosil boʻlgan monoalmashgan, dialmashgan, gomoanulyar, 

geteroanulyar hosilalarini analiz qilishda ularning IQ va PMR spektrlaridan 

C8 
-

0.364 
C16 

-

0.208 
    C8 0.286 C17 0.678     C8 

-

0.349 
C17 0.693     

C9 
-

0.359 
C17 0.644     C9 

-

0.265 
O1 

-

0.481 
    C9 

-

0.379 
O1 

-

0.497 
    

C10 
-

0.359 
O1 

-

0.483 
    C10 0.481 O* 

-

0.554 
    C10 

-

0.280 
O* 

-

0.548 
    

H2 0.247 O* 0.555     H2 0.252 H* 0.390     H2 0.261 H* 0.92     

H3 0.209 H* 0.367     H3 0.262 H13 0.251     H3 0.360 H13 0.251     

H4 0.209 H13 0.220     H4 0.256 H14 0.228     H4 0.257 H14 0.232     

H5 0.202 H14 0.192     H5 0.257 H15 0.221     H5 0.260 H15 0.231     

 H7 0.209 H15 0.194      H7 0.260 H16 0.201      H7 0.269 H16 0.215     

H8 0.209 H16 0.207     H8 0.273 C6* 0.678     H8 0.258 C3* 
-

0.568 
    

C6* 0.633 H61 0.216     H9 0.273 H61 0.258     H9 0.256 H31 0.246     

2 b* 3 3a 

C1 -0.281 C11 -0.020 H33 0.217 C1 -0.224 H9 0.212 C1 -0.104 H10 0.272 H82 0.244 

C2 -0.287 C12 -0.083 H10 0.210 C2 -0.328 C11 -0.002 C2 -0.408 C11 -0.010 H83 0.256 

C3 -0.179 C13 -0.158     C3 0.357 C12 -0.201 C3 -0.277 C12 -0.198     

C4 -0.347 C14 -0.185     C4 -0.350 C13 -0.18 C4 -0.314 C13 -0.173     

C5 -0.358 C15 -0.175     C5 -0.368 C14 -0.166 C5 0.366 C14 -0.151     

C6 -0.379 C16 -0.185     C6 -0.355 C15 -0.095 C6 -0.280 C15 -0.094     

C7 -0.354 C17 0.628     C7 -0.363 C16 -0.192 C7 -0.379 C16 -0.188     

C8 -0.365 O1 -0.467     C8 -0.359 C17 0.656 C8 -0.444 C17 0.677     

C9 -0.365 O* -0.546     C9 -0.361 O1 -0.492 C9 -0.381 O1 -0.466     

C10 -0.356 H* 0.368     C10 -0.358 O* -0.564 C10 -0.283 O* -0.568     

H2 0.232 H13 0.211     H2 0.205 H* 0.368 H2 0.248 H* 0.387     

H4 0.205 H14 0.193     H3 0.209 H12 0.216 H3 0.261 H12 0.228     

H5 0.203 H15 0.195     H4 0.211 H14 0.214 H4 0.263 H14 0.247     

 H6 0.211 H16 0.204     H5 0.209 H15 0.193 H5 0.250 H15 0.224     

H7 0.218 C3* -0.627      H6 0.220 H16 0.197  H6 0.281 H16 0.196     

H8 0.208 H31 0.217     H7 0.207 H10 0.213 H8 0.317 C8* -0.534     

H9 0.208 H32 0.210     H8 0.211     H9 0.266 H81 0.244     
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foydalanish mumkin. Chunki ularning IQ spektrlarida ferrotsen yadrosidagi bir 

vodorod almashinishi natijasida hosil boʻlgan monoalmashgan hosilalarida 

almashinmagan tsiklopentadienil yadrosi uchun 1100-1000 sm-1 qiymatida intensiv 

nur yutilishi kuzatiladi. 3080-3005 sm-1 da nur yutilishi esa aromatik halqa 

mavjudligidan dalolat beradi. 3500-3400 sm-1 keng shakldagi nur yutilganligi 

molekulada gidroksil guruh mavjudligini koʻrsatadi. Quyida keltirilgan 2-rasmda 

p-ferrotsenilfenol molekulasining PMR spektri keltirilgan. Unga koʻra, 3.98 m.u. 

dagi singlet signal ferrotsenning almashinmagan tsiklopentadienil aromatik 

halqasidagi 5 ta protonga tegishli. Ferrotsenning monoalmashgan tsiklopentadienil 

halqadagi 2,5 va 3,4 protonlariga hos boʻlgan duplet va triplet signallar mos 

ravishda 4.25 va 4.62 m.u. da kuzatiladi. Benzol halqasining 4 ta protoni 6.7-7.46 

m.u. larida kvartet signalini beradi. Gidroksil guruhi protoni esa 8.26 m.u. da 

signal beradi [9]. 

 

20-rasm. p-Ferrotsenilfenolning PMR spektri 

Lekin hozirgacha bu birikmalarda kvant kimyoviy usullar yordamida nazariy 

tadqiqotlar yetarlicha oʻtkazilmagan. 

Mazkur ishda biz p-Fc-Ph-OH ni Gaussian 98W dasturining DFT/DGDZVP 

metodi yordamida IQ spektrlarini va DFT/B3LYP gibrid metodining 6-311G 

bazisida PMR spektrlarini oldik va tahlil qildik [19-rasm]. 

                  A                              B 
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21-rasm. A. p-ferrotsenilfenolning fazoviy tuzilishi; B. Molekulaning Gaussian 98W dasturida 

hisoblangan IQ spektri (I-1,4-almashingan aromatik halqa; II- C5H4R; III-C5H5; IV-OH). 

Olingan natijalarga koʻra p-ferrotsenilfenolning IQ spektrida ferrotsenning 

almashinmagan halqasi uchun xarakterli boʻlgan 3776,93sm-1da, monoalmashgan 

halqa uchun esa 1135,22sm-1 da 1,4-almashgan aromatik halqa uchun esa 1109,17 

sm-1 da gidroksil guruh uchun esa sm-1da yutilish chiziqlari hosil boʻldi (10-jadval). 

Quyidagi grafikdan (1-chizma) koʻrinib turibdiki, gidroksil guruhi tebranish 

chastotalari qolgan funktsional guruhlar tebranishidan keskin farq qiladi: 1- va 2-

grafik chiziqlari sifat jihatdan oʻzaro mos keladi. Qolgan guruhlarning 

eksperemental olingan tebranish chastotalari nazariy hisoblangan kattaliklarga son 

jihatdan ham mos kelishi kuzatiladi. Nazariy hisob bazislarining keyingi 

chuqurlashuvi, bizning fikrimizcha, gidroksil guruhi tebranishlarini ham nafaqat 

sifat, balki son jihatdan ham aniqlashga yordam beradi. 

DFT/DGDZVP metodida olingan natijalar 

№ Guruh nomi 
Adabiyotlardan olingan 

natijalar 
DFT/DGDZVP da 

1 -OH 3500-3400 sm-1 3776,93 sm-1 

2 
 

1100-1000 sm-1 1135,22sm-1 

3 
 

1130-1020 sm-1 1109,17sm-1 

4 
1

2 3

5

4

6  

3080-3005 sm-1 3001 sm-1 

Nazariy hisoblangan PMR spektrlarida almashinmagan halqa 

tsiklopentadienil protonlari signallarning 3.23 m.u.da natija berishi va 1,4-

almashgan aromatik halqa protonlarining 5.35-6.03 m.u. dagi natijaviy signallari  

adabiyotdagi keltirilgan eksperimental olingan PMR spektrlarining 2-rasm 

signallariga mos kelishi, ushbu oʻtkazilgan kvant kimyoviy hisoblashlardagi 

tanlangan metodi (DFT) va bazisi (6-311G) toʻgʻri tanlanganligini koʻrish mumkin. 
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4.3. p-Ferrotsenilfenol va ferrotsenilbenzoy kislotari fazoviy 

tuzilishining kvant kimyoviy tahlili 

Mazkur ishda sendvichsimon tuzilgan ferrotsen va uning hosilasi 

ferrotsenilbenzoy kislotasining (1-sxema) fazoviy hamda elektron tuzilishini 

zamonaviy kvant kimyoviy usulda oʻrganish maqsad qilib qoʻyilgan. Ushbu 

moddalarning fazoviy tuzilishi, atomlardagi elektronlar taqsimotini oʻrganish bilan 

ularning reaksion qobiliyatini aniqlash mumkin. 

1-sxema. Ferrotsen va ferrotsenilbenzoy kislotasining fazoviy tuzilishi 

 Tuzilishiga koʻra ferrotsen nobenzoid, aromatik xossaga ega (10-jadval). 

Uning hosilasi ferrotsenilbenzoy kislotasi esa kuchsiz kislota xossasiga ega. 

Ferrotsen huddi benzolga oʻxshab oʻrin olish reaksiyasiga kirishsa, 

ferrotsenilbenzoy kislotasi esa oʻrin olish hamda kislotalarga xos reaksiyalarga 

kirishadi.  

 

 

 

 

          1                                                                2 

 Ferrotsenilbenzoy kislotasining fazoviy tuzilishini oʻrganish uchun 

zamonaviy kvant kimyoviy dastur – GAUSSIAN 98W ning DFT/B3LYP gibrid 

metodi va 6-311G bazisidan gaz fazasi yordamida hisoblashlar olib bordik. 

Hisoblashlar shuni koʻrsatdiki, molekuladagi benzol halqasi planar, tekis 

strukturaga ega. Ferrotsen halqasida bogʻ uzunliklari va valent burchak qiymatlari 

uglerod atomining sp2 gibridlanish holatlariga mos boʻlib, dC-C=1,44±0,2Å ga teng; 

valent burchagi esa C-C-C=119,25o, karboksil guruhdagi C=O bogʻining oʻrtacha 

bogʻ uzunligi dC=O~1,24 Å ga teng. Gidroksil guruh kislorodi bilan uglerod atomi 

orasidagi bogʻ uzunligi dC-O~1,38 Å ga teng. Ushbu kattaliklar adabiyotdagi 

qiymatlarga mos keladi va biz tanlagan metodning toʻgʻriligini koʻrsatadi. 
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11-jadval. Ferrotsen molekulasidagi fizik kattaliklar 

Atom 
DFT 

Zaryadi, e Atom Zaryadi, e Bogʻ uzunlgi, Å Valent burchgi, (φ, grad.) 

C1 -0.25875 H1 0.167515 C1-C2 1.439 C1-C2-C3 107.99 

C2 -0.25847 H2 0.167517 C2-C3 1.439 C5-Fe-C7 140.02 

C3 -0.25904 H3 0.167499 C3-C4 1.439 C6-C10-C9 107.99 

C4 -0.25893 H4 0.167525 C4-C5 1.439 H1-C1-C2 126.00 

C5 -0.25841 H5 0.167516 C5-C1 1.439 H1-C1-Fe 128.76 

C6 -0.25903 C6 0.167500 C-Fe 2.046 C2-C1-C5 107.99 

C7 -0.25842 H7 0.167515 C6-C7 1.439   

C8 -0.25892 H8 0.167526 C7-C8 1.439   

C9 -0.25847 H9 0.167517 C8-C9 1.439   

C10 -0.25876 H10 0.16752 C9-C10 1.439   

Fe 1.577   C-H 1.076   

Natijalar tahliliga koʻra, (12-jadvalga qarang) karboksil guruhi tarkibiga 

kiruvchi kislorod atomi reaksion qobiliyatining yuqoriligini kislorodda manfiy 

zaryad yuqoriligini koʻrish mumkin. Ferrotsen (11-jadval) va uning hosilalari 

atomlarida zaryad oʻzgarishini taqqoslash mumkin. Masalan,  

12-Jadval.Ferrotsenilbenzoy kislotasi molekulasi atomlaridagi fizik kattaliklar 

Atom 

DFT 

Zaryadi, 

e 
Atom 

Zaryadi, 

e 

Bogʻ uzunliklari, 

Å 

Valent burchgi, 

(φ, grad) 

C1 -0.202 C12 -0.164 C=O 1.24 O18-C17-O19 120.9239 

C2 -0.197 C13 -0.139 O-H 0.98 C14-C17-O18 125.7847 

C3 -0.204 C14 0.063 C12-H12 1.08 C14-C17-O19 113.2913 

C4 -0.212 C15 -0.130 C2-H2 1.086 C13-C14-C15 119.2520 

C5 -0.169 C16 -0.167 C6-H6 1.09 C2-C1-C5 106.8606 

C6 -0.206 C17 0.411 C-O19 1.38 C5-Fe-C7 108.2735 

C7 -0.209 O18 -0.418 C14-C17 1.47 H1-C1-Fe 125.7633 

C8 -0.209 O19 -0.570 C1-C2 1.44 H1-C1-C2 125.9107 

C9 -0.208 H2 0.152 C-Fe 2.08 C1-C2-C3 108.5482 

C10 -0.212 H6 0.155     

Fe 1.572 H13 0.167     

C11 0.144 H19 0.387     

13-jadval. 1-va 2-molekulalardagi toʻla energiyasi va dipol moment kattaliklari 

Molekula 
DFT/ B3LYP/6-311G 

Toʻla energiyasi, kkal/mol Dipol momenti, Debay 

1 

2 

-10299,6 

-12979,5 

0.0011 

2.9739 

Jadval kattaliklari hamda yuqoridagi sxemalarda 1-molekula va 2-

molekuladagi uglerod atomlarining zaryad taqsimotlari oʻrtasidagi oʻrtacha farq q= 
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0,06 ga teng boʻlib, elektron zichlik karboksil guruhi tomon siljiganligini koʻrish 

mumkin. Ferrotsen molekulasining aromatiklik xususiyatini 11-jadvalda keltirilgan 

dipol momentining 0 ga yaqinligidan, 2-molekulaning reaksion qobiliyati 

yuqoriligini ham dipol momenti μ= 2,9739D ga tengligidan bilish mumkin.  

Ferrotsenilbenzoy kislotasining yuqori reaksion qobiliyatiga ega ekaligini 

elektronlarning karboksil guruhi tomon siljiganligi bilan izohlash mumkin. 

Ferrotsen va uning hosilalari reaksion qobiliyatlari ularning fazoviy tuzilishiga 

bogʻliq.   

Ferrotsen hosilalarining fazoviy tuzilishi, oʻrinbosarlarning ferrotsen 

halqasiga ta’siri hamda reaksion qobiliyatini GAUSSIAN98 dasturining 

DFT/B3LYP gibrid metodi va 6-311G bazisi yordamida oʻrganish reaksiyaning 

yoʻnalishi va mexanizmini oldindan bashorat qilish uchun optimal metod sifatida 

tavsiya etamiz. 
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Xulosa 

 p-Ferrosenilfenol va ferrosenilbenzoy kislotasining alkillash reaksiyalarini 

kvant kimyoviy usul bilan oʻrganish natijasida tegishli xulosalarga kelindi: 

1. Ushbu magistrlik dissertatsiyasida ferrotsen va uning hosilalarining 

fizik-kimyoviy xossalari, sintez qilish usullari, eksperimental natijalar 

adabiyotlarda, ilmiy jurnallarda chop etilgan materiallar, hamda internet 

ma’lumotlari asosida oʻrganildi. 

2. Eng muhim benzoid  va nobenzoid birikmalarning aromatiklik 

xossalari Gaussian 98W dasturining DFT/B3LYP gibrid metodi 6-31G bazisida 

tahlil qilindi. 

3. p-Ferrotsenilfenol va ferrotsenilbenzoy kislotasining molekulyar 

geometriyasi, xususan atomlararo masofa va Malliken boʻyicha atomlardagi 

zaryadlarning taqsimlanishini kvantomexanik hisoblashlar asosida 

oʻrganilganda eksperimental natijalarga mos ekanligi aniqlandi. 

4. p-Ferrotsenilfenol va ferrotsenilbenzoy kislotasining alkillash 

reaksiyasi Gaussian 98 W dasturi DFT/B3LYP noempirik metodi 3-21G 

bazisida modellashtirildi. Siklopentadiyenil halqasiga oʻrinbosarlarning ta’siri 

kvant kimyoviy usul bilan oʻrganildi. 

5. Hech bir tadqiqotchi tomonidan zamonaviy kvant kimyoviy metodlar 

yordamida oʻrganilmagan p-ferrotsenilfenol va ferrotsenilbenzoy kislotasini 

alkillash reaksiyasining mexanizmi zamonaviy kvant kimyoviy metodlar 

yordamida oʻrganildi. Fridel-Krafts metodida alkillash reaksiyasi asos qilib olindi. 

Dastlabki, oraliq, oxirgi hosilalarning geometriyasi, zaryad taqsimoti, valent 

burchaklari va energetik kattaliklari Gaussian98W dasturida DFT/B3LYP 

metodining 3-21G bazisida olib borildi. Zamonaviy kvant kimyoviy tahlil 

natijasida dastlabki va sintez mahsulotining geometrik koʻrsatkichlari taqqoslandi 

va sintez mahsuloti natijalari nazariy hisobga mos kelishi aniqlandi. 
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6. Mazkur tadqiqot ishida toʻplangan ma’lumotlardan OTM va kasb-hunar 

kollejlari, akademik litsey oʻqituvchi hamda talabalari metodik qoʻllanma sifatida 

foydalanishlari mumkin.  
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